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Welcome to
Storybook Weaver is a versatile writing tool for the Apple IIGS
computer, designed to engage students in the writing process.
Storybook Weaver!
Storybook Weaver allows students to author a story or storybook.
Through writing, students intertwine the language arts—reading,
writing, speaking, listening, and thinking—as they weave their ideas
into the pictures and stories they create. Since young students first
writing experiences often focus on that which is familiar to them,
Storybook Weaver builds on these experiences by emphasizing a
theme young people know best—"my world around me." This theme
is represented through the colorful scenery and objects available for
creating their pictures.
Storybook Weaver allows students to create their tapestry of ideas,
words, and pictures as they design the fabric of their stories. By
allowing students to move easily between pictures and story text,
Storybook Weaver provides flexibility in the writing process. From
creative writing to book reports to letters, Storybook Weaver can be
used in any forum in which students are encouraged to write.
Storybook Weaver comes complete with help screens and a section
that provides a step-by-step look at the product
Students can create pages that include pictures and text or text only.
Storybook Weaver includes a variety of foreground and background
scenes and colors that can be combined to create a setting that invites
students to write. Students can select from eight different categories
of objects to include in their picture. All objects can be previewed
before being placed in a picture. Objects can be manipulated by
enlarging, reducing, flipping, and coloring the images. Pages can be
combined to create storybooks that students can print
Storybook Weaver has many unique features as well. Scenery can
be created in two parts. With separate foreground and background
choices, students can interchange parts to create their own scene.
The "Day" and "Night" buttons allow students to further customize
the setting for their story. A "Spell" button encourages students to
use words from their picture in their writing as they place words in
their story. And selecting "Choose a story to read" from the main
menu provides an opportunity to "page through" stories written by
other authors.
By weaving together the language arts, Storybook Weaver will
provide your students with an exciting opportunity to express
themselves through their writing.
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Storybook Weaver
The Product at a Glance
How to Use This
Manual

There are seven sections in this manual.
The first section, "The Product at a Glance," briefly describes
Storybook Weaver and details the computer rationale behind its
development, the required equipment, the Apple IIGS desktop, and
how files can be stored.
The second section, "Getting Started with Storybook Weaver," takes
you through a series of steps to get started with Storybook Weaver.
You will see an overview of the different cursor types used in the
product, the various means of clicking with the mouse, and the Help
screens available.
The third section, "A Step-by-Step Look at Storybook Weaver,"
introduces you to Storybook Weaver and many of its functions. As
you follow "A Step-by-Step Look at Storybook Weaver," you will
learn about the process of creating a story page. You might want to
use this section to introduce Storybook Weaver to your students.
The fourth section, "Exploring the Features of Storybook Weaver"
covers each menu and menu item in succession. Each menu is
discussed in detail, and many tips and techniques regarding each
menu item are given. You will also find a complete discussion of
each dialog box associated with a menu item. If you need specific
information about a menu item or dialog box, go to this section.
The fifth section, "Answers to Questions About Storybook Weaver,"
looks at specific questions that teachers have asked and attempts to
answer them as thoroughly as possible. Before you call MECC's
Help Line, check this section to see whether your question is
answered here.
The sixth section, "Use in an Instructional Setting," gives an
overview of the writing process and provides suggestions for
incorporating Storybook Weaver into the curriculum. This section
also offers a number of suggestions for using writing activities that
can be completed using Storybook Weaver.
The final section, "Appendices," offers a listing of the scenery and
object selections available in Storybook Weaver, a bibliography, and
a glossary of terms.
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In addition to the descriptive section headings used throughout this
manual, the outside margins contain several special symbols designed
to be recognizable at first glance.
The hand icon warns of potentially "hazardous" activities that, if
performed incorrectly, could result in frustration and wasted effort.

The reminder icon marks tips and hints that apply to the basic
operations of Storybook Weaver.

The eyeglasses icon outlines creative options that you may add to
your Storybook Weaver document or refers you to additional sources
of information.
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These icons will alert you to important information as you use
Storybook Weaver.
Storybook Weaver is an open-ended writing tool which actively
engages students in the writing process. Students can author and
illustrate their own stories using a simple word processor and a
variety of graphic features. Mixing and matching from a selection of
foreground and background colors and scenes, students can create a
variety of settings. To illustrate their storyline, students select from a
collection of over 300 graphic objects that students can manipulate by
changing color, size, and orientation. Storybook Weaver has the
flexibility to accommodate the wide range of reading and writing
skills of primary-aged students. For some, Storybook Weaver will
provide an introduction to writing while for others it will provide an
enriching environment in which they can exercise their existing skill
base.

V

Description

Storybook Weaver
Computer Rationale

Based on the thematic approach of Storybook Weaver, students are
encouraged to write about the world they know best: the world
around them. Storybook Weaver reinforces vocabulary
development, sequencing, classification, and writing with a purpose.
Storybook Weaver was created to:
• allow students to explore the writing process using a
simple word processor to author a story;
• allow students to create illustrations that visually depict their
storyline;
• allow students to author a story that depicts their
illustration;
• give students opportunities for purposeful writing;
• provide students opportunities to share their writing with
an audience while others read their stories;
• foster thinking skills as students work through the writing
process;
• utilize students* inherent creativity to write and illustrate
a story;
• enhance students sight-word vocabulary by associating a
word with its related picture;
• develop sequencing skills as students author a story using
the writing process.

Equipment
Required

To use Storybook Weaver, you need the following equipment:
• an Apple IIGS computer with ROM Version 01 or greater, a
mouse, and at least 1 megabyte of memory;
• two 3.5" 800K disk drives are required (a 5.25" drive is
optional for saving stories);

Storybook Weaver
a color monitor (a monochrome monitor can be used, but
without full benefit of the capabilities of the product); and
an Apple printer (any ImageWriter or LaserWriter) or a
compatible Epson printer.
Before using Storybook Weaver, you should be familiar with the
Apple IIGS desktop, clicking with the mouse, selecting and dragging
objects, dialog boxes, and file selection menus. Refer to your
Apple IIGS Owner's Guide for more information on these subjects.

Apple IIGS
Desktop

The Storybook Weaver program comes on two 3.5" disks, but files
can be saved to 5.25" or 3.5" disks. Storybook Weaver files saved on
disk require different amounts of storage space. This size depends on
the make-up of the document: the number of pages, the number of
graphics, and text.

Storybook Weaver
Disk Information

Writing is a powerful instrument of thought As students are engaged
in the writing process, they learn about themselves and their world
and they communicate their insights to others. Students learn to write
by writing. It is our hope that Storybook Weaver will become an
integral part of your classroom writing environment

Storybook Weaver
Getting Started with^S^
Follow these steps to begin using Storybook Weaver.

Starting Up

Step 1: Insert the Storybook Weaver System disk into Drive One
and the Storybook Weaver Program disk into Drive Two.
Step 2: Turn your Apple IIGS on and wait for the desktop to
appear. This takes approximately one minute.
Step 3: If the Storybook Weaver Program disk window has not
appeared on the screen, use the mouse to click the
Storybook Weaver Program disk icon to highlight it.
Step 4: Next, pull down the File menu and select Open. You can
also open the program disk by double-clicking on the
Storybook Weaver disk icon.
(The "Clicking with the Mouse" section, beginning on page 11, better
explains what "clicking" means and describes different methods of
using the mouse.)
In the picture below, the Storybook Weaver icon is one of several
appearing on the desktop. The Storybook Weaver disk is "open" and,
in the disk window, you can see the Storybook Weaver program icon.
You can "close" the disk by clicking on the Close box in the upperleft corner of the disk's title bar or by selecting Close from the File
menu.

6
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Trash

The system disk icon is closed. You can open it by double-clicking
on it or by clicking the mouse on the icon once to select it and then
selecting Open from the File menu. You can remove a disk from the
desktop by clicking on its icon once to select it and then selecting
Eject from the Disk menu.
The trash can appears in the bottom-right comer of the screen. Files
and folders can be "thrown away" by dragging them into the trash
can. If you double-click on the trash can, or if you select the trash
can and then select Open from the File menu, you can "open" it to see
its contents. You can drag documents or folders out of the trash can
and back onto the desktop or onto a disk.
Discarded files or folders stay in the trash can until you select Empty
Trash from the Special menu, or until you start a program. Emptying
the trash can permanently remove files and folders from the disk.
Once you do this, they are gone forever. Be careful using the trash
can! You will not get a prompt informing you that you are about to
delete files or folders when you empty the trash. If you attempt to put
certain locked files in the trash can, you will get the alert shown in
the screen below:
The file/folder "PRODUCT.INFO" is locked
(or contains items that are locked).
Remove it anyway?

c

Cancel

Dc

No

3C
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We advise you to cancel immediately. Never put a program icon or a
system folder in the trash can.
You can eject a disk by dragging its icon to the trash can. We
recommend that you use the standard menu method: Select the disk
you wish to eject by clicking on it once. Then, select Eject from the
Disk menu.

Storybook Weaver
Step 5: Click on the Storybook Weaver icon to highlight it. Pull
down the File menu and select Open or double-click on
the Storybook Weaver icon. Storybook Weaver will begin
loading.
The computer takes about a minute to open the program,
during which time the title screen appears:

ZZI
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Version 1.0
by Charolyn Kapplinger,
Patricia Korn, John J. Krenz,
Brian S. Nesse, Jean Sharp,
and Steve Zehm
3M90 Lexington Avenue
St. Paul, MN 55126-8097
C612) 1181-3500
Copyright MECC, 1990
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Step 6:

You see the main menu options for Storybook Weaver.
The main menu options will be described on pages 15-16.
At the top of the screen is the menu bar. These menus
contain options described in this section and in the
"Exploring Features of Storybook Weavef9 section.

r~-

Storybook Weaver
The main menu of Storybook Weaver appears below. Each of these
options will be explained in detail in the "Step-by-Step Look at
Storybook Weaver" section.
& F i l e E d i t G o o d i e sM f M T C fl V ^ ^

Start a new story.
Choose a story to finish.
Choose a story to print.
Choose a story to read.
I would like to quit now.

Different Types of
Cursors

tit&ys'

i

If you've used Apple IIGS programs before and are familiar with the
use of the mouse, you are already acquainted with the various types
of cursors that appear to reflect various program features:

t The "Selection" Cursor
The selection cursor is used to perform most basic program
functions, including selecting menu items, clicking on the various
buttons on the tool or color palette, and selecting, moving, and
coloring objects in the picture window.

0

The "Wait" Cursor

The familiar wait cursor indicates that the program is in the process
of canying out a command or some other function you have
implemented. Until it changes back to some other type of cursor,
you can't execute another command.

Storybook Weaver
Getting Started with Sforyboofr IVea^er
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The "I-beam" Cursor

The I-beam or text cursor appears when you are in the story window
or entering text on the title page. This cursor allows you to click
anywhere in your story and edit it You can also highlight text by
dragging across a selection of text. As soon as you click the mouse,
the I-beam will disappear and the insertion point cursor will appear.

J The "Insertion" Point Cursor
The insertion point appears at the current cursor location in text The
insertion point flashes its position on the screen. This is the point at
which text is typed or inserted into the story document. The insertion
point is placed by clicking the mouse. The insertion point remains at
its location even after you pick up the mouse to move it. It will
remain at its location until the mouse is clicked at a new location.
To use Storybook Weaver, you need to be familiar with the
Apple IIGS desktop interface. Here is a quick look at how the mouse
works. If you need additional information, see your Apple IIGS
Owner's Guide.
Various types of "clicking" actions with the mouse have different
effects with different items, as noted:
In Menus:
Hold down the mouse button—Pulls down a menu.
Move the mouse with the mouse button down—Highlights
menu items.
Release mouse button—Selects highlighted menu item.

10

Clicking with the
Mouse

Storybook Weaver
Getting Started with Sfo^oo^e3,er
On Graphic Objects:
Click—Selects a single object. All previously selected
objects are de-selected.
Shift-click—Selects or de-selects an object without
de-selecting any previously selected objects.
Click and Drag—Selects and moves an object. All
previously selected objects are de-selected.
Shift-click and Drag—Selects and moves an object. All
previously selected objects remain selected and are also
moved.
Outside of a Graphics Object:

/^^^^\

Click and Drag—Selects all objects within the selection
rectangle. All previously selected objects are de-selected.
Shift-click and Drag—Selects or de-selects all objects
within the selection rectangle. All other previously
selected objects remain selected.
When Editing Text:
Click—Moves the insertion point to the place clicked.
Any previously selected text is de-selected.
Shift-click—Extends the current text selection to the place
clicked.
Click and Drag—(Click and hold down the mouse button.)
Selects a range of text.
Double-click and Drag—Selects a range of words.
Selected objects remain selected.

v
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Storybook Weaver
Getting Started with Storybook Weaver
In Dialog Boxes:
Click—Selects a single item. All previously selected
items are de-selected. Or, moves the cursor to a text entry
field. A highlighted box is the pre-selected input field
where typing will be displayed.

Help screens are always available by selecting Help... from the #
menu. The page numbers that appear in the on-line Help refer you to
manual pages that provide further explanation.

Getting Help (3-?)

Step 1: Pull down the # menu and select Help.
Step 2: In the dialog box that appears, select the type of help you
would like from the list of available help topics: Apple
Menu, Color Palette, Cursors, Edit Menu, File Menu,
Goodies Menu, Main Menu Options, Mouse Functions,
Objects, Page Features, Scenery, Text, Title Page, or Tool
Palette.

^

H e l p To p i c s
fippl e Menu

Color Palette
Cursors
Edit Menu
File Menu
Goodies Menu
Main Menu Options
Mouse Functions

(pages
(pages
(pages
(pages
(pages
(pages
(pages

M0-UT51

1 0 - 11 5
61-63}
52-61}
63-69}
15-16}
11 - 1 3 } 1

[CanceTllt HeTp

It's a good idea to read through the different sections of this manual.
If in doubt about a particular menu item, consult the "Exploring
Features of Storybook Weaver" section, which details the functions
and options available with each menu item.

/**^^\

12

Storybook Weaver
When the main menu for Storybook Weaver appears, you may start a The Main Menu
new story, finish or edit a story that you began earlier, print a story, or
choose a story to read. You may also exit Storybook Weaver by
selecting "/ would like to quit now." You may select any option from
the main menu by clicking on the menu icon.
I

■mm®

<fr

File

Edit

Goodies

S t a r t a n e w s t o r y.

nHJZ

C h o o s e a s t o r y t o fi n i s h .

IjIK

Choose a story to print.

UK

"1

:$i?8S:-
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Choose a story to read.

yp*

I would like to quit now.

Hi

Start a new story:
If you are ready to begin writing a new story, select "Start a new
story" This option will take you to the title page where you can enter
the title of your story, the author, and other information.
Choose a story to finish:
If you have a story you have already saved on a data disk and you
would like to finish writing that story, or if you have a story you have
written that you would like to edit, select "Choose a story to finish"
You will need to have the data disk where your previous story is
saved.
Choose a story to print:
Once you have written a story, you can print a copy of your story. If
so, select "Choose a story to print." Storybook Weaver will ask you
to locate the story you wish to print
13

Storybook Weaver
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Choose a story to read:
This unique feature of Storybook Weaver, "Choose a story to read,"
allows you to access any saved story to read, much the same way that
you would read a printed storybook. In this mode, Storybook
Weaver does not allow you to edit a story.
/ would like to quit now:
Selecting this option will allow you to exit Storybook Weaver.
If you have not yet authored a story using Storybook Weaver, select
"Start a new story" This will take you to the title page where you
can enter some information about your story.

The Title Page

On the title page, you can enter a title for your story, list the name or
names of the author, and add other information such as the name of
your school, your teacher or class, the date, or a summary line for
your story. You can also select from a variety of borders to enhance
your title screen. The information you enter on the title page can be
edited at any time during the writing process by returning to the title
page. This is done by clicking on the left-page turning button at the
bottom of the screen. Once you reach the Title page, the left-page
turning button will beep, indicating that you are at the beginning of
your story.
& File Edit Goodies
[ Title ]
[ fl u t h o r l
I Info 1
[Border]

i Ti t l e P a g e I
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If you prefer to enter your Title Page after you have completed
your story, you may click on the right-page turning arrow to
continue. You may return to the Title Page by clicking on the leftpage turning arrow.
To enter a title for your story:

Entering a Title

Step 1: Click on the Title button. A text box with a blinking
cursor will appear on the title page.
Step 2: Use the keyboard to enter the name or title of your story.
The title will appear in a large, bold font centered in the
Title text box.
Step 3: Place your title on your title page by clicking on the text
box. When the resizing handles appear, move your title to
the location you desire.
&

File

Edit

Goodies

[ Title ]
[Author]
[

Info

| A Picnic by the Sea j

]

[Border]

Color m|^|

^■o b o ^ h

iTitle

Page

I

ho^

To change the tide of your story, click on the Title button. The title
text box will reappear around your current title. The blinking text
insert cursor will be positioned at the beginning of your current title.
You may now edit your title using normal text-editing procedures.
For further information on editing text, see page 39.

15
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Entering an Author

To enter an author or authors for your story:
Step 1: Click on the Author button. A text box with a blinking
cursor will appear on the title page.
Step 2: Use the keyboard to enter the author or authors names.
This will appear in medium-size, bold font centered in
the Author text box.
Step 3: Place the author's name(s) on your title page by
clicking on the text box. When the resizing handles
appear, move your title to the location you desire.
&

File

Edit

Goodies

[Title]
[Buthorl
[

Info

A Picnic by the Sea

]

Andrew Ryan

[Border]

i Ti t l e P a g e I
To change the author or authors of your story, click on the Author
button. The author text box will reappear around your current
author. The blinking text insert cursor will be positioned at the
beginning of the text box. You may now edit this information using
normal text editing procedures. For further information on editing
text, see page 39.
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Info allows you to enter additional information about your story.
Entering Info
This may include the name of your school, your teacher or class, and
the date your story was written. You may also wish to use this box to
enter a summary of your story. Just like entering the title and author,
to enter information about your story:
Step 1: Click on the Info button. A text box with a blinking
cursor will appear on the title page.
Step 2: Use the keyboard to enter the information you want to
include about your story. This information will appear in
a medium font centered in the Info text box.
Step 3: Place your information on your title page by clicking on
the text box. When the resizing handles appear, move
your Info text box to the location you desire.
&

File

[ Title ]
[ fl u t h o r l
[ Info ]
[Border!

Edit

Goodies

A Picnic by the Sea
Andrew Ryan

j A story about a day with my family j
! September 14,1990 j

Title Page I

To change the information about your story, click on the Info button.
The Info text box will reappear around your current information. The
blinking text insert cursor will be positioned at the beginning of the
text box. You may now edit this information using normal text
editing procedures. For further information on editing text, see
page 39.

*m<
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Selecting a Border

You may select a border to enhance your title page. Storybook
Weaver contains a selection of ten pre-designed borders. You also
have the option to have no border on your title page.
To select a border for your title page:
Step 1: Click on the Border button. The first of ten pre-designed
borders will appear around the title page.
Step 2: Click on the Border button again. The second border will
appear surrounding the title page. Continue clicking the
Border button to scroll through the available borders until
you find the one you like. You may choose to have
no border if you desire.
Step 3: You may need to reposition your text to fit within your
border. In Storybook Weaver, the text may also overlay
the border.

Your Storybook Weaver Program disk contains a border file that
holds all of the available borders for use with Storybook Weaver.
The colors of the borders cannot be changed.

18
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On the title page, there are two text modes: an editing mode that
allows you to make text changes and a non-editing mode that allows
you to move text on the title page. To move into the editing mode,
click on the Title, Author, or Info buttons. The text box will appear
as a dotted outline box. In the non-editing mode, simply click on the
text region on the title page itself. The text box will be defined with
four black rectangles called resizing handles.
Colored text may be entered for the title, author, or information.
Each section of the title page may have the same or different colored
text. The first four rows of colors on the color palette are available
coloring text. To color text you can:

Coloring Text

• Select the color from the color palette you want your text to
appear. Click on the Title, Author, or Info button. The text
will be entered in the color you selected. Or
• Select the text you wish to color by clicking on the
corresponding text box to select the text Select the color
you desire from the color palette. The selected text will
appear in that color.
The text colors on the title page may be changed at any time by
returning to the title page and selecting another color.
In addition to coloring text, you may move text on the Title page
using the non-editing mode. The text boxes may be resized using the
resizing handles, the small black rectangles that appear on the comers
of a selected text box. This allows you to customize the title page by
placing the tide, author, and information anywhere you desire on the
title page.

19

Resizing the Text
Box

Storybook Weaver
To resize a text box on the title page:
Step 1: Select the text box you wish to resize. Clicking on the
text will reveal the resizing handles.
Step 2: Click on one of the handles and drag the mouse until
your text box resizes to the shape you desire. Your text
will automatically fit within the new dimensions of your
text box.
Step 3: Drag the text box to the location you desire on the title
page.
Once you have entered your information on the title page, click on the
right-page turning button to proceed to the next page.
Choosing a
Page Type

If you are writing a new story, you will be asked to choose what your
new page will look like. Storybook Weaver provides two page types,
pictures and text or text only.

^

^
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The picture and text page provides for two or four lines of story text,
depending on the font size you select.
&

F i l lb E d i t G o o d i e s

nisi *

* 0
scenery objects
bigger smeller

-WW
flip spell

(Imp)

trash
Color |^^^

H
4mh

1

Page

1

1

wmm^^

The text only page allows either nine or eighteen lines of story text
Small or large font can be set under the Goodies menu or under
Preferences on the File menu. For more information on font size, see
pages 63-65.
Edit Goodies
scenery objects
bigger smaller
flip

spell
trosh

Color!

I Page 1 "T
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Page type can also be set under Preferences in the File menu. The
default is set to "choice/' allowing you to select your page type. If
desired, you may set the page type to automatically default to picture
and text or text only. For additional information on Preferences, see
page 57. For our "Step-by-Step Look at Storybook Weaver" select a
picture and text page.
The Main Work
Screen

If you select a picture and text page, the main work screen will look
like the screen pictured below. This is the main interaction screen
where you will create your storybook page. The main work screen
consists of five regions: the picture window, the story window, the
tool palette, the color palette, and the page-turning buttons.
Story
Window

Tool Palette

m

File

Edit

Picture Window

Goodie

scenery objects
bigger smoller
fl i p

spell
trosh

Color Palette Page Turning Buttons
The picture window is the largest portion of the main work screen.
This area is reserved for the placement of the scenery and the objects
you have selected to use in your story.
The story window is located directly under the picture window and is
reserved for your story text. The simple word processor used in
Storybook Weaver allows for upper- and lower-case letters and word
wrap. Entering, editing, and deleting text are explained, beginning on
page 38.
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If you selected a text only page, the picture window would not be
available and the story window would occupy the portion of the
screen now comprised of the picture window and the story
window. Hie text-only screen is shown on page 23.
The tool palatte is located along the left side of the main work screen.
This palette consists of eight buttons that allow you to select and
manipulate scenery and objects placed in your picture window. The
buttons found on the tool palette include scenery, objects, smaller,
bigger, flip, spell, stop, and trash. Each of these buttons is explained
in more detail on pages 26-38.
The color palette occupies the lower left side of the main work
screen. This palette is comprised of 24 color choices that can be used
to color objects placed in your picture window. The first four rows of
colors on the color palette can be used to color text in the story
window. For more information on the color palette, see pages 40-41.
The page turning buttons are located at the bottom of the main work
screen, just beneath the story window. The page-turning buttons
move you through your story one screen at a time, much like turning
the pages of a book. You can move forward or backward using the
right or left page turning buttons. Your current page is displayed in
the center rectangle between the arrows. Page turning buttons are
further explained on pages 41-42.
While the regions of the main work screen are highlighted in
detail on the following pages. Storybook Weaver does not
suggest a specific sequence that you must follow in order to
create your story page. As an open-ended writing tool,
Storybook Weaver provides the flexibility you desire as a
writer. You may choose to begin with writing or you may
choose to begin with yourpicture. Whatever your decision,
Storybook Weaver puts you in control of the approach and
sequence that best fits your writing style.
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Selecting Scenery

To gain an understanding of the picture window, you must have some
objects to manipulate. Objects you will use in the picture window
can all be obtained using die buttons on the tool palette. Using the
scenery button, you can create either a color or a scene for your
picture setting.
In order to place scenery in your picture window, you must:
Step 1: Click on the scenery button on the tool palette.
Storybook Weaver takes you to the scenery selection
screen that allows you to make your scenery choices.
Step 2: Use the arrow cursor to select either "colors" or
"scenes" as your scenery option. The two rows of
buttons along the bottom of this screen provide
foreground and background choices. The top row of
six buttons indicate the options available for the
background of your picture. The bottom row of six
buttons indicates the options available for your
foreground. Foreground and background options can
be intermixed to provide 36 possible color
combinations and 36 possible scene combinations.
Step 3: Select a background from the top row of choices and
a foreground from the bottom row of choices.
Step 4: Click on the "OK" button to return to the main work
screen.
Cfr

File

Edit
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Cblore and scenes may not teMe^
In other words, you may create a setting that consists of colore or
a setting that consists of scenes. You may not create it setting
that is part color and part sceneWhen you select "scenes" as your background and foreground
choices, the "Day" and "Night" buttons will be activated. To switch
between daytime and nighttime settings, simply click on the
appropriate buttons. To return the scene to its previous view, select
the other button. You can return to the main work screen by clicking
on the OK button.
The daytime or nighttime setting may be changed at any time by
returning to the scenery selection screen and selecting your new
option.

y^BlPfcy
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Buttons
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Youmaynotmterarixthedayandmghts^
Weaver. Your scene wifl^pe^ only in a daytime or a
nighttime view.
The "Day" and "Night" buttons are active for scenes only. These
buttons are dimmed if you have chosen the "color" option for your
scenery.
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Changing the
Scenery

and {scenes available in Sto^book Weaver, sw the Qhm on
page 102.
Your scenery may be changed at anytime during your writing. New
scenery may be selected as you add pages to your story or you may
wish to edit or change your story to use a different setting. To change
the scenery you have placed in your story:
Step 1: Click cm the scenery button on the tool palette.
Step 2: Use the arrow cursor to select either "color" or "scenes"
as your scenery option.
Step 3: Select your background from the top row of choices and
your foreground from the bottom row of choices. Your
new choices will appear in your picture window.
Step 4: Click on the "OK" button to return to the main work
screen.
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If you have objects that you have already placed in your picture
window and you decide to change your scenery, Storybook
Weaver will automatically put your previously placed objects on
the newly selected scenery.
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The "objects" button on the tool palette allows you to choose from a Choosing Objects
variety of objects to place in your picture window. Eight categories
of objects are available in Storybook Weaver. These categories
include people (children), people (adults), big animals, small animals,
nature, vehicles, shelter, and things.
The people (children) category contains a variety of children and
activities in which they may engage. The people (adult) category
contains a variety of adults and occupations in which they might be
employed. The animals categories are divided by size into big
animals and small animals. Nature includes a variety of objects that
relate to weather, as well as trees, flowers, and other growing things.
The vehicles category contains airplanes, cars, trucks, trains, and
boats. Shelter includes various buildings that would be found in the
child's community. Things includes a variety of objects that might be
used by children in these settings.
Object
Categories

Picture Window
Edit Goodies

baseball player
biker

boy sitting
camper
dancer

More Objects C

Selection
Boxes
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The objects selection screen is composed of four major regions. The
categories appear on the left side of the screen in the same location
that you would find the tool palette on the main work screen. These
categories serve as a means to classify the more than 300 objects
available for placement in the pictures you create with Storybook
Weaver.
The selection boxes contain the names of the actual objects that you
can place in your picture. The selection boxes display nine objects at
a time. More objects are available in each category. You can scroll
through the objects by clicking on the right or left arrows beneath the
object selection boxes. This will allow you to move forward or
backward in the category to locate an object you wish to place in your
picture.
The "preview box" appears in the lower right comer of the screen.
This box allows you to view an object before placing it in your
picture window. It also serves to reinforce vocabulary as die picture
appears when the word is selected.
The picture window, which is the same as the window on the main
work screen, occupies the largest portion of the screen and permits
you to place your selected objects immediately in your picture.
Selecting and
Placing Objects

To select the objects you wish to add to your picture, you must:
Step 1:

Step 2:
Step 3:
Step 4:

Step 5:

Select "objects" from the tool palette on the main work
screen. When the objects selection screen appears, the
upper left category, people (children), will be selected
and its choices will fill die selection boxes. In the upper
left selection box, "baby" will also be selected and the
corresponding object will appear in the "preview box" at
the lower right comer of the screen.
Locate the category from which you wish to select an
object.
Locate the object you wish to place in your picture.
To place an object from the preview box onto your
picture window, click and drag the object from the
preview box to the location you wish the object to
appear.
Release the mouse button to place the object.
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I More Objects [
Objects selected for placement in your picture may come onto the
picture window in several ways. New objects can appear in the
picture window in the same size they appear in the preview box.
If you desire, new objects can appear in the picture window in
their ideal size. This means that some of the objects will spring to
a larger size once you release the mouse button. This option may
be set under Preferences on the File menu.
If you drag an object from the preview box onto the picture window
but don't release the mouse button to place the object, you can drag
the object back into the preview box to dispose of it. Objects placed
on the picture window by dragging and releasing the mouse button
may not be dragged back into the preview box.
To place multiple copies of the same object in your picture
window, select the object desired. Click and drag each object to
place the number of objects you wish in your picture.
You may place a maximum of 50 objects in the picture window on a
given story page.
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Yoo may select objects from several different categories before
returnmg to me main work screen. However, in order to size,
fBp, or color objects, yon must return to the main work screen by
clicking the "OK" button.

Moving Objects

f •l-v

You may move objects within your picture window at any time
during the creation of your picture. To move an object in the picture
window:
Step 1: Select the object you wish to move.
Step 2: When the "handles" appear, click anywhere on the
object and drag it to its new location.
Step 3: Release the mouse button to place the object in your
picture.
You can move several objects at once by holding down the Shift Key
and clicking on the objects you wish to move. When the group of
objects has been selected, drag the objects to the new location.
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In addition, holding down the (3 Key while pressing one of the arrow
keys will move any selected object or objects one pixel in the
direction specified.
Objects that you have placed in your picture window may be deleted
in several ways. If you are on the main work screen, you may
remove objects from your picture by:
Step 1: Selecting the object or objects you wish to delete from
your picture.
Step 2: When the handles appear, click on the trash can icon on
the tool palette. The object or objects will be removed.
You may also remove objects either from the main work screen or the
objects selection screen by selecting the object or group of objects
you wish to delete and pressing the Delete Key.
An entire page of objects may be removed by choosing "Select All"
from the Edit menu and using the trash can icon or the Delete Key.
You can also delete an entire page of objects by selecting Clear under
the Edit menu.
Objects that have been deleted can be retrieved by selecting Undo
under the Edit menu. This operation must occur immediately after
the objects have been deleted
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For a complete listing of the objects available in Storybook
Weaver, see the chart on pages 103-110.
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Once you have placed some objects in your picture window and have
returned to the main work screen, you may manipulate these objects
using the bigger, smaller, and flip buttons that appear on the tool
palette.

Making Objects
Bigger

The bigger button allows you to increase the size of an object in
incremental steps. To enlarge an object:
Step 1: Select the object you wish to enlarge by clicking on the
object to select.
Step 2: When the handles appear, click on the bigger button to
resize the object.
Step 3: If the object is at its maximum size, the object will
remain unchanged.
You may enlarge a group of objects at the same time by selecting the
objects you wish to enlarge and clicking the bigger button.
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When resizing a group of objects at one time, some objects may
reach their maximum size before other objects.
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The smaller button allows you to reduce the size of an object in
incremental steps. To reduce the size of an object:
Step 1: Select the object you wish to reduce by clicking on the
object to select.
Step 2: When the handles appear, click on the smaller button
to resize the object.
Step 3: If the object is at its minimum size, the object will
remain unchanged.
You may reduce the size of a group of objects at the same time by
selecting the objects you wish to resize and clicking the smaller
button.

Any object that has been resized using the bigger or smaller buttons
may be returned to their original size in one of two ways:
• Select the object that has been resized by clicking on the
object to highlight. Select Ideal Size from the Goodies menu.
The object will revert to its predrawn or best size.
• Select the object When the handles appear, click on
the trash can icon to delete the object from your picture
window. Select a new object by clicking on the objects
button from the tool palette and retrieve a new object from
the object selection screen.
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Flipping Objects

To change the direction of an object or group of objects, you can use
the flip button that appears in the tool palette on the main work
screen. To change the direction of an object, you must:
Step 1: Select the object or objects you wish to flip by clicking
on the object to select.
Step 2: When the handles appear, click on the flip button to
change the orientation of the object.
Step 3: The object will appear facing the opposite direction.

The Spell Button

Children's oral-language skills are often more developed than their
written-language skills. In Storybook Weaver, the primary focus is
on the writing process. Therefore, the Spell button offers a unique
feature in that it allows you to place the word of a selected object in
your story text even if you don't know how to spell the word. To
operate the Spell feature:
Step 1:
Step 2:
Step 3:
Step 4:

Select the desired insertion point in your story window
by placing the insertion point in the location you want
the object word to appear.
Move into the picture window and use the arrow cursor
to select the object you want to include in your story.
Click on the "Spell" button on the tool palette.
The selected object's name will appear in the story
window at the insertion point you designated. The
insertion point will appear after the spelled word so
that you may continue to enter your story.
34
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The name or label for the object you select will be the same name that
appears in the selection boxes on the objects selection screen. Only
those objects that you currently have placed in your picture window
may be used with the Spell button for insertion into your story.

The Spell button operates only on objects that you have placed in
your picture using the objects selection screen. Objects that
appear as part of the scenery cannot be placed in your story text
The Spell feature functions on one object at a time.
Two additional buttons that appear on the tool palette include Stop
and Trash. Selecting the Stop button will allow you to quit your
current story. You will be prompted to SAVE your story before
quitting.
The trash button allows you to delete any object or objects that you
no longer want in your picture window. To delete an object using the
trash can icon, you must:
Step 1: Select the object or objects you wish to delete.
Step 2: When the handles appear, click on the trash can button
on the tool palette.
Step 3: The object or objects will be deleted.
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Stop and Trash
Buttons
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The trash can button functions only on objects you have placed
in your picture window from the objects selection screen. You
cannot remove any of the objects that are included as part of the
scenery*

The Story Window

If you have chosen a picture and text page, the story window occupies
the lower one-third of the main work screen and is reserved for the
text portion of your story. For a text-only page, the story window
occupies the entire picture window and story window area. Storybook
Weaver uses a simple word processor with word wrap and upper- and
lower-case letters.

Entering Your Story

To enter your text in the story window, use the keyboard in a typical
word-processor manner:
Step 1: Select the size of the text you want in the story window.
You may choose either small font or large font Font
size is set under the Goodies menu or under Preferences
on the File menu.
Step 2: Move your cursor to the story window on the main
work screen. The I-beam cursor will appear.
Step 3: Select the insertion point by clicking the mouse at the
location in the story window you wish to begin writing.
Step 4: Use the keyboard to enter your story.
When the story window is full, you will receive the following
message:
&
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The text object has become
longer than the page. The
extra text can't be printed.

Color

I It was a warm spring day. The flovers were blooming.
It was a perfect day for a picnic. Sister carried the
I picnic basket to the front yard. We were about to
1 spread the blanket on the grass when a little bunny

I Page ±
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You can also activate the story window by entering text from the
keyboard The text appears in the story window.
The insertion cursor may be moved to any position in the text window
using either the arrow keys or by using the mouse's "I-beam" cursor
to point and click at the desired insertion point
Text may also be "pasted" into the text window using the cut, copy,
and paste commands available under the Edit menu. For more
information on these features, see "Exploring the Features of
Storybook Weaver," beginning on page 43.
You may edit or change your story text anytime during the writing
process simply by moving to the story window.
To insert a word or words in your story text:
Step 1:
Step 2:

Move the insertion point cursor to the location in your
story where you want to add words.
Use the keyboard to enter the word or words you wish
to add to your story.

To change or edit words in your story:
Step 1: Move the I-beam cursor to the beginning of the text
you wish to change.
Step 2: Hold down the mouse button and drag the cursor to
highlight the text you wish to edit
Step 3: Release the mouse button to select the text
Step 4: Use the keyboard to enter the text you wish to add to
your story.
You may also select text to edit by holding down the Shift Key and
using the arrow keys to move the cursor and highlight text you wish
to edit
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Deleting Text from
Your Story

Text may be deleted from your story using any of the following
methods:
• Highlight the text you wish to delete and press the Delete
Key.
• Highlight the text and select Clear from the Edit menu.
• Highlight the text and select Cut (C5-X) from the
Edit menu.
• When in the story window, choose Select All from the Edit
menu and press die trash icon, the Delete Key, or the Clear
Key.

Using "Spell"

The Spell button on the tool palette allows you to place text for
objects appearing in your picture window in your story. For
information on the Spell button, refer to page 36.

The Color Palette

The color palette occupies the lower left comer of the main work
screen. The color palette allows you to color the objects you have
placed in your picture window. You may also color the text that
appears in your story window. Twenty-four colors are available on
the color palette.
To color an object using the colors on the color palette:
Step 1: Select the object or group of objects you wish to color.
Step 2: When the handles appear, click on the color you desire
from the choices available on the color palette.
Step 3: The selected object or objects will become that color.

Some objects ^pear la theptewiew box i^ portion of the
object colored The predetermined colors cannot be changed
However, any ansa of the object that is not pre-colored can be
filled with your choice of any color from the color palette.
The text in the story window, as well as the text that appears on the
title page of your story, can also be colored The first four rows of
colors on the color palette are available for coloring text
To color text using the colors on the color palette:
Step 1: Move your cursor to the story window on the main
work screen.
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Step 2: Select the color you desire from the choices available
on the color palette.
Step 3: Use the keyboard to enter your story text. The text will
appear in the selected color.
To change the color of your story text:
Step 1: Select the text you wish to color.
Step 2: Once the text has been highlighted, click on the color
you desire from the choices available on the color palette.
Step 3: The text will become that color.
The color of objects and text may be changed at any time by
reselecting the object or text and repeating the procedure outlined
above.
You can move from one page to another in your story simply by
clicking on the left- or right-page turning buttons that appear at the
bottom of each page. The page-turning buttons operate in much the
same manner as turning the pages of a book. You will use the rightpage turning button to proceed to the next page. If the next page of
your story is also a "new" page, you will be prompted as to what you
would like the new page to look like—pictures and text or text only.
Clicking on the left-page turning button will take you to the previous
page completed in your story. You may continue to click the leftpage turning button until you return to the tide page of your story.
The current page of your story is indicated in the rectangle between
the left- and right-page turning buttons.
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Page-Turning
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Storybook Weaver has a page limit of 50 pages per story. When you
have reached the page limits of Storybook Weaver, the right-page
turning button will beep.
Additional page options are available under the Goodies menu and
are explained on pages 67-69.
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The Menu Bar

File Edit Goodies

This is the Storybook Weaver menu bar. Each item contains a
separate pull-down menu. When you hold down the mouse button
while pointing the arrow cursor at one of the menu items, the menu
will pull down and display the individual menu items.
The menus contain other functions in Storybook Weaver, text
options, picture and object features, and page options.
Each menu is discussed separately in this section. We begin on the
left with the # menu and proceed to the right, finishing with the
Goodies menu. With each menu, we begin at the top and move to the
bottom, discussing each menu item in turn. The # menu provides
access to Storybook Weaver information, help, and any desk
accessories installed on your system. The Storybook Weaver System
disk comes with three desk accessories: Control Panel, MECC Key
Caps, and Disk Accessory.
About Storybook Weaver...
Help...
6?
Control Panel
MECC Key Caps
Disk Accessory
About Storybook Weaver,

-Stortj&ooll
Wearer
Ve r s i o n 1 . 0
b u C h a r o l u n K a p p l i n g e r,
Patricia Korn, John J. Krenz,
Brian S. Nesse, Jean Sharp,
and Steve Zehm
3M90 Lexington Avenue
St. Paul, MH 55126-8097

C612) 181-3500
IK

OK

II
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This menu item displays the product name, the MECC development
team, and other information about Storybook Weaver.
Help... (C5-?)
Help provides you a list of topics that you can select to get more
information. The page numbers refer you to the manual for further
explanation.
H e l p To p i c s
flpp 1 e Menu

Color Palette
Cpages
Cursors
(pages
Edit Menu
Cpages
File Menu
Cpages
Goodies Menu
Cpages
Main Menu Options Cpages
Mouse Functions Cpages

M3-52 >

M0-M1}|
1 0 - 11 )
61-635
52-61!)
63-69)1
15-16)1
11 - 1 3 ) 1

[Cancel ]l| Help jl

Control Panel
The Control Panel (standard on the Apple IIGS) allows you to select
from a list of devices that are connected to your computer directly or
over an AppleTalk network. When you are using Storybook Weaver
on an AppleTalk network or when you have more than one printer
connected to your computer, you will use the Control Panel to select
a printer.
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Control Panel
Select a Port:

RppleShare
AT I W r i t e r

Select a Printer Tune:
ImaqeWriter

LaserWriter

vl.0 I Help

The Control Panel displays icons of the available devices on the left
If there are more than five devices, this is a scrollable list of icons.
Devices could include a variety of printers, modems, drives, and
servers. The current device is highlighted.
A printer device might be an AppleTalk Image Writer (AT IWriter), a
Direct Connect (DC) Printer, or a LaserWriter. If there is more than
one similar device, selecting an AppleTalk ImageWriter will prompt
you to select one from a list of ImageWriters in the upper-right You
can also specify in which zone to look for an AppleTalk
ImageWriter—should your network have more than one zone. If you
are not on an AppleTalk network, the AppleTalk Zones box is blank.
AppleTalk networks must have at least one zone, each with its own
set of available printers, modems, and other devices.
The Control Panel provided with the Storybook Weaver System disk
is specifically for device selection and should not be confused with
the Control Panel for the Apple IIGS. The Apple IIGS Control Panel
is used to specify a variety of settings for the computer itself: display,
sound, clock, speed, slots, printer and modem ports, and RAM disk.
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MECC Key Caps
MECC Key Caps allows you to find a complete set of diacritical
marks and foreign language and special characters available with
each font so that you can locate the characters needed to enter text
in a foreign language. When you select MECC Key Caps, you will
see a keyboard diagram that shows the keys in the current font.
MECC Key Caps 1.3

[ Font 1

Ill2l*lnl*l«lrl.l9l0l-I.|

*
7 8 9 +
M 5 6 —
s

l a l w l e l r I t l u uli IoIpIc 1:1
|a|s|d|f|g|h|j|k|ll:M
Izlxlclvlblnlml, 1- V 1

1

1

hi

/

1 2 3
0
.

N

By holding down the Shift Key, the Option Key, the Apple Key, the
Control Key, or any combination of those keys, the set of characters
associated with those key combinations is displayed on the keyboard
diagram. The selected font is the system, or "Shaston," font. The
Choose Font button in the top-right comer allows you to select a
different font, style, and size.
MECC Key Caps font selection:
:ont:
Helvetica
London
Los Angeles
Madrid
San Francisco
Shaston
Style:

H

Plain

|_| Bold
□
Italic
CZI Underline
□ Outline
1 1 Qhnrlorktmi

O

hSJ

KBH?
16

Size•

US 1
[Cancel]

IF

ft

OK

t|

Any text copied from Key Caps to Storybook Weaver will appear in
the standard font chosen for Storybook Weaver.
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Disk Accessory
Disk Accessory allows you to perform certain disk operations, such as
formatting a disk, deleting, or renaming a file without exiting
Storybook Weaver. When you select Disk Accessory, you will see
the following screen:
Disk Accessory

Available Disks:

[ Disk Scan ]

Jystem.Di^

:Story Book. Info
<RPPLEDISK5.25R>
<RPPLEDISK5.25B>

[Initialize]
[ Delete 1

Type: ProDOS
Size:
800K
Free Space: 10K

[ Get Info ]
[ Rename ]

The scroll box on the left side of the screen contains the disk volumes
that are currently available. When you click on a disk volume in the
scroll box, you will get information about that volume. Disk
Accessory will display the disk type, size of the volume, and disk free
space. If there is no disk in the drive, the device name will be
displayed with the <greater than> signs around it.
Disk Scan will update the devices currently displayed in the scroll
box. If you have inserted or removed disks or devices, you may wish
to scan disks.
In order to save your story documents you can initialize either a 3.5"
or a 5.25" disk with Disk Accessory. To initialize a disk using Disk
Accessory, select the "Initialize" button. The Disk Accessory will
determine if there is a disk in the current drive. If no disk appears in
the drive, you must insert one. The dialog box appears below.
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Insert a disk in "RPPLEDISK5.25A"

[ Cancel ]

C

OK

1
3

If you select "OK," Disk Accessory will check to see if the disk you
inserted is an unformatted disk. You will be presented with this alert:

©

This operation will
PERMRNENTLV destroy all
data on this disk. Rre you
sure you want to do this?

[ Cancel ]

[ Continue ]

You may proceed with the initialization process or select "Cancel,*
which returns you to the main window. If the disk you inserted is
formatted, the following alert is presented:

©

This operation will
PERMRNENTLV destroy all
data on the disk
"RPPLEDISK3.5R>ai. Rre you
sure you want to do this?

[ Cancel ]
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If you indicate that you want to format the disk, you can enter a name
for the disk. The following dialog is displayed:

Enter a name for this disk:

i
[

]
Cancel

]

[Initialize]

Selecting "Initialize" will format the disk. Once this process is
complete, Disk Accessory returns you to the main window.
Selecting "Eject" will remove your disk from the selected drive.
Delete may be used to remove files and folders from the selected disk
volume. When you select "Delete," the Disk Accessory presents the
following dialog box:
Q:Story Book. Info:
S e l e c t t h e fi l e t o D e l e t e :
Disk

)

((

Open

))

[

€ i <*<><>

3

Delete

)

Q Borders

□ PRODUCT.INFO
^Weaver
□ We a v e r. P r e f s
□ We a v e r. d o t a

(

Cancel

Folders may be opened or closed from this screen. You may delete
files and folders or return to Disk Accessory's main window by
selecting "Cancel." To delete a file, highlight the file you wish to
delete. Click on the delete button that appears on the right side of the
screen. Disk Accessory will display the following alert:
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fire you sure »ou want to
P E R M R N E N T LV d e l e t e t h e
fi l e " B o r d e r s " ?

&

[

Cancel

C

J

OK

3

You may cancel either procedure by selecting "Cancel." You will be
returned to the "Delete" screen.
Get Info allows you to view the known information about a file. You
may also set information for a particular file. When you select this
option, a standard file dialog is displayed. Once you select a file, the
following dialog is presented:

Get Info
Name: Weaver
Size: 105K on disk
Created: 09/13/90...08:M4
M o d i fi e d : 0 9 / 2 M / 9 0 . . . 1 0 : 0 5
Where: /Story Book. Info/Weaver
Type:
$B3
fl u x T y p e : $ 0 0 0 0
[

Cancel

□

c

]

Locked

OK

3

You may lock or unlock a file by clicking in the box labeled
"Locked." An X will appear when a file is locked.
"Rename" gives you the option of entering a new name for a file.
When you select "Rename," the following dialog box is displayed:
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l:StoryBook.Info:
S e l e c t t h e fi l e t o R e n a m e

Disk

□ PRODUCT.INFO
□ Park.Scene
□ Pathways...
□ Picnic
□ P i c n i c . b y. S e a
□ Seashore.Scene
□ Seaside.Picnic
^Weaver
□ We a v e r. P r e f s

((

Open

J

(

C 1 <»<>«>

]

(

Rename

)

Cancel

You must select the file you wish to rename by clicking on that file to
highlight. Once the file has been selected, the following dialog is
displayed:
Rename: Borders
To: | l:MIMJILJ
[

Cancel

]

c

Rename

Enter the new file name and select "Rename,
procedure by selecting "Cancel."

3

You may cancel this

Clicking on the area of the main menu screen above the scroll box
will give you information about Disk Accessory. The screen includes
information about Disk Accessory, the MECC development team, and
other information.
Disk Rccessory
Ve r s i o n 1 . 0
Written by Vincent Erickson
MECC
3490 Lexington Rvenue
St. Paul, MN 55126-8097
C612) M81-3500 _

49

OK

>
3

Storybook Weaver
To quit the Disk Accessory, click in the close box, the small rectangle
that appears at the top left comer of the menu bar.
The File Menu

The File menu provides access to the basic functions of the
program—opening, saving, and closing documents—as well as the
document preferences, page setup, and printing functions. The File
menu also includes the option to quit Storybook Weaver.
This is the File menu:
Hew

s«

(Iper*...

50

Close
aw
Save
as
Save Rs...
Revert; To Saved
PreferencesPage Setup...
Print...
<SP
Quit
6Q

New (C5-N)
This menu item creates a new, untitled story for Storybook Weaver.
A new story document will have the specifications set under
Preferences. See "Preferences..." in this section for information on
how to change these settings. New documents are named '"Untitled.9
In Storybook Weaver, selecting New ((5-N) brings up the Title page
and prompts you in the creation of a new story.
Open...(G-0)
This menu item opens a previously saved Storybook Weaver
document to edit or finish. Open brings up the standard Open dialog
box.
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S e l e c t fi l e t o o p e n :
<9:StoryBook.Info:
□ Nature.Scene |Q1 [
□ Park.Scene IBJ
□
Pathways...
Hi
□ P i c n i c . b y. S e a
□ Seashore.Scene
t
□ Seaside.Picnic
□ W i n t e r. S c e n e
□ Zoo
O (

Disk
Open
Close

)

-J

Cancel

)
)

The dialog box contains a scrollable list of Storybook Weaver
documents. Use the scroll bar and scroll arrows to move up and
down the list of files. The scrollable list of folders and file names is
in alphabetical order. You can select the file by double-clicking on it
or by clicking the Open button when the file you want is highlighted.
Once the story file has been opened, you will find yourself on the last
completed story page.
You can switch the drive from which the files should be opened by
clicking the Disk button in the dialog box or by pressing the Tab Key.
You can also save documents on 5.25" drives by selecting the 5.25"
disk drive control device from the Control Panel.
You can open a document from the desktop by douW^
the Storytook Weaver docwxmtic^ When yon
do this, you will mxt Storybook Weaver and load your document
at the same time*
Close ((3-W)

This menu item closes the story document but does not exit
Storybook Weaver. If you have not saved all of your changes, you
will be asked whether you would like to save your work. The alert
box looks like this:

< &

Save changes before closing?

[ Cancel ] [Don't Save! H Save
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If you press the Cancel button, you will return to the document.
Save (C5-S)
This menu item saves the story document with its current name. Save
replaces without any prompt, the older version of the story document.
If you have not saved the story document before, you will be
prompted to name the story document.
With a new story document, the pre-set name is "Untided." This
name appears in the Save As edit box that prompts you to name this
file. To erase the name "Untitled," you can:
• press the Delete Key and erase characters one at a time;
• press the Clear Key (upper left comer of the 10-key keypad);
or
• double-click on Untided to select for replacement.
Then enter the name you wish to use.
QrStoryBook.Info:
234 free of 800 k.
□ Borders
Q C tmw* rig. Scene
QCkttf.kkds
Q C cos t ruofci on
QfcU.So<>rM»
Q f <»*!». Scene
Save as:
| Untitled"

Disk

i

New Folder ]
Open

D

0 lose
Save
Cancel

File Names. On a stand-alone machine using GS/OS, file names
may contain letters or numbers, such as "letter" or "letterl2." Letters
can be in upper- or lower-case, such as "MyStory." They may have
extensions, such as "story.sept" or "story.septl4," separated by a
period. File names may be up to 15 characters long, such as
"Congratulations." File names cannot:
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• have only numbers in the name, such as "14";
• begin with numbers, such as "14sept.story";
• use special characters (@#&*/), such as "story#l/sept/14";
• have any punctuation marks except the period (!?,;:),
such as "Hello!"; or
• contain spaces, such as "My Story."
If you try to save a file name that is not acceptable, you will see this
system message:

©

E r r o r s a v i n g t h e fi l e :
The pathname has changed or is now
i n e r r o r. .
f t C a n c e l fl

Basically, what the system message is trying to tell you is that the file
name is not acceptable. If you get this message, first check your file
name to see if it has any of the special characters or a space in it.
Then, check to see if there is a folder or active disk with that name.
In any case, you will need to change the name of the file to save it.
If you are using Storybook Weaver on an AppleShare network, file
names may contain spaces, numbers at the beginning of die name,
or other special characters.

It is a very good idea to regularly save your work to prevent losing
anything in the event of a power interruption or surge or other
system-related problem. Depending on the amount of memory in
your machine and the size of your story document, you may get an
alert message to save because of low memory.
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©

M e m o r y i s r u n n i n g l o w. B e
sure to save your document
f r e q u e n t l y.

tt_gj<-J)
If this ever happens, save your story document immediately. If you
ignore this message, continue working, and attempt to save later, you
may not have enough memory to complete the operation and will
lose all the work since you last saved it.
Save As...
This option allows you to save the document currendy in use with a
different name (thus preserving the previously saved version of the
document) and/or on a different disk.
Revert to Saved
This option replaces the document on the screen with the latest
version saved. This is the same as throwing out all changes since the
last save. If the document has never been saved or if the document
has not been modified since it has been saved, the item is dimmed.
Before reverting to the old document, you will be warned with this
alert:

/ h Rv eervsei or tn toof tyhoeu rl adsot c su amveendt ?
IH Cancel ^D [ Revert ]
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Preferences
This menu item allows you to set permanent system preferences that
will be stored on the disk and will be used as die initial preferences
with each new story document
You can specify the initial font size to appear in the story window.
If you have chosen a picture and text page, small font allows for four
lines of story text and large font allows for two lines of story text On
a text-only page, selecting small font will provide for eighteen lines of
story text and large font will provide nine lines of story text To
change from small font, the default selection, click on the large font
button.
Preferences also allow you to set the page type for each new story
page. "Choice" is selected as the default, which means that each time
you use the page turning buttons to take you to a new page, you will
be given the choice of creating a page that contains pictures and text
or text-only. You may change the page type under Preferences so that
the new page type will automatically be selected as pictures and text
or text-only if desired.
The changes made under Preferences take effect on your new story
page.
If you select text-only under |»eferences»yo8^^betislng
Storybook Weaver without M benefit of all the features
avaHable. You wffl use the keyboard to enter your st<^y text and
the color palette will be available for coloring text
You may determine the movement of objects in the picture window.
The default is set for objects to appear in the order in which they were
brought to the picture window. To move an object in front of another
object, you must use the Bring to Front option on the Goodies menu.
By selecting "Bring Objects to Front When Moved," objects that are
selected and moved to a new location will appear in front of other
objects.
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You may also determine how new objects appear from the preview
box to the picture window. If you would like the objects to come to
the picture window in the same size as they are shown in the preview
box, select preview size. If you would like new objects to appear in
the picture window in their ideal size, you may select that option. In
selecting Ideal Size, some of the objects will spring to their optimum
size once you release the mouse button to place the object in the
picture window.
The final option you may set under Preferences is the printed format.
This refers to the number of story pages that will be printed on each
printer page. The current default is set to print one story page per
each printer page. If you choose, you may have Storybook Weaver
print two story pages per each printer page.
Preferences
Font:
(g> Small
O Large

New Objects Rppear:
<S> Preview Box Size
OIdeal Size

Page Type:
<S> Choice
O Pictures & Text

Printed Format:

O Te x t O n l y
□ Bring Objects to -r—
Front When Moved ICance

DC

OK

y

Page Setup...
This menu item calls up the standard Apple IIGS Page Setup dialog
box for the printer selected in the Control Panel.
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You can select paper size, vertical sizing, and any printer effects.

LaserWriter
v3.0
Paper: <S> US Letter O RM Letter
O US Legal OB5 Letter
Orientation
Ve r t i c a l S i z i n g :
<S> Normal
llnfiil
OIntermediate
O Condensed
Printer Effects:
Reduce or
S Smoothing?
Enlarge:
E3 Font Substitution?
ance

ReeiI*

a

ImageWriter/Pr inter
v3.0
Paper: <S> US Letter
OUS Legal
O RM Letter
OInternational Fanfold
Vertical Sizing: Printer Effects:
<S> Normal □ 50% Reduction
O Condensed □ No Gaps Between
Orientation:
Pages
[

Cancel
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Print... ((3-P)
This menu item prints the story document to the currendy chosen
printer. Depending on the selection you have made in the Control
Panel, you will see the standard Apple IIGS Print dialog box for the
LaserWriter or the ImageWriter
LaserWriter
v3.0
P a g e s : < $ > R 11
O F r o m : | | To : | ^
Copies: |Q |
Paper Source:
<§> Paper Tray
O Manual Feed
[ Cancel ] £ O K 1

v3.0

ImageWriter/Modem

Q u a l i t y : O B e t t e r Te x t
<S> Better Color
O Draft
Page range:
® Rll

Q From: |
I T.: [ZZI
Copies: |B |
Paper Feed:® Rutomatic O Manual
IS

Color

[

Cancel

1

ft

OK

Tl

You can print all the pages or select a range of pages from the story
document, specify the number of copies to print, and select "Manual
Feed" or "Paper Tray" as the paper source. Storybook Weaver
allows for story documents of up to 50 pages. The Tide page is
designated as page 0.
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Weaver
Quit(C5-Q)
This option allows you to exit Storybook Weaver. If there were any
changes in the currendy open story document that haven't been saved,
the following alert will appear

y^V Save changes before quitting?
[ Cancel ] [Don't Save] H Save

The Edit menu manages the manipulation of story text and objects.
You can cut, copy, and paste selections of story text and objects.
This is the Edit Menu.
iit\tii>

SZ
<SX
AC
£ V

Cut
Copy
Paste
Clear
Select

Rll

6R

Undo (C5-Z)
This menu item will undo your last action. The specific name of the
menu item will depeqd on which action is to be undone. When you
are typing text, it will read "Undo Typing." If this were executed,
the menu item would then read "Redo Typing." If you selected text
and cut it, it would read "Undo Cut" It is dimmed when unavailable.
Undo will undo Cut, Copy, Paste, and Select All commands, any
changes to font size, and any deleted object or text. Undo will also
undo Clear, Move object, and Color object.
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Cut ((3-X), Copy ((3-C), and Paste ((3-V)
These menu items remove or duplicate and place selected text or
objects. They act like they do in other applications and are dimmed
and inactive if there is no text or object selected. Selected text can be
a range of characters, a word, or a range of words. You can select text
by using shifted arrow keys, by dragging the mouse, or by using
Select All.
Cut removes text from its current position and holds it in memory so
that it can be pasted in some other location. Cut can be invoked by
pressing (3-X. A second cut replaces any text or objects previously
cut
Copy duplicates selected text so that it can be pasted at some other
location and holds the duplicated text in memory until another Copy
or Cut is performed. Copy can be invoked by pressing (3-C. A
second copy overwrites any text or objects that had been copied.
Paste takes whatever text has been cut or copied and places it at the
current insertion point Move the I-beam to where you want to paste
the cut or copied text, click the mouse to create the insertion point,
and select Paste or press (3- V. Text that has been copied can be
pasted multiple times.
When you use Cut and Copy, you hold this text in memory in a place
called the clipboard. Text will stay in the clipboard until you copy or
cut a second time.
Cut, Copy, and Paste can also be used with objects in the picture
window. Whenever an object {or group of objects) has been
selectedtitcanbecutorcopied. When you select Paste, the
object is placed in the center of the picture win^ It can then
be moved or manipulated
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Clear
This menu item deletes the current selection. If something is cleared,
it cannot be pasted later. This menu item is dimmed if nothing is
selected. Clear works for text and objects in the picture window,
deleting the currendy selected text or objects. Cleared text or objects
cannot be pasted later.
Select AD ((3-A)
This menu item selects all of the text in the story window or all of the
objects in the picture window on the current story page.
The Goodies menu manages the manipulation of text size in the story
window, object size, and page features.
This is the Goodies Menu.

Goodies

v Small Font
Large Font
Bring to Front
Send to Back
Ideal Size
Delete Page
Insert a Page
Copy a Page..
Swap Pages..
Go To Page..

AF
£B
61
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Small Font
This menu item allows you to change the size of the text that appears
in the story window. If you have chosen a picture and text page,
selecting small font will give you four lines of story text If you have
chosen a text-only page, selecting small font will provide eighteen
lines of story text Small font is selected as the default in Storybook
Weaver.
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Exploring the Features of Storybook Weaver
tifc File Edit Goodies

I Later that day we took our pail and shovel to the shore
IVe built a sand castle by the edge of the water. The
J sand castle had huge towers. Ve found seashells and put
I them at the castle door. What a fun day!

Large Font
This menu item allows you to change the size of the text that appears
in the story window. If you have chosen a picture and text page,
selecting large font will give you two lines of story text If you have
chosen a text only page, selecting large font will provide nine lines of
story text The larger text is sometimes desired for young readers and
writers.

62

Storybook Weaver
Font size may be changed under the Goodies menu or under
Preferences in the File menu.
The font size xmy be changed fkra page to page in your story.
However* font size may not be mixed on individual pages. In
other words, once smaUfcmt is selected, your entire page will
appear in that size until you change the setting for a new page, A
check mark (V) will appear next to the cunient font in the Goodies
menu.
Bring to Front ((3-F)
This menu item brings the selected object in the picture window to
the foreground, in front of other objects. In effect, this option
reshuffles the object order and places the selected object at the top of
the pile.

Send to Back (C3-B)
This menu item sends the selected object in the picture window to the
background, behind other objects. In effect, this option reshuffles the
object order and places the selected object at the bottom of the pile.
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Exploring the Features of Storybook Weaver

Ideal Size ((3-1)
This menu item changes the size of the objects to their pre-drawn or
best size. Often times, after an object has been resized using the
bigger or smaller buttons, you will want to return the object to its
ideal or best size. This feature allows you to accomplish that task by
selecting the object or objects you wish to revert and selecting Ideal
Size from the Goodies menu or pressing ((3-1).
You may also set Ideal Size in Preferences under the File menu to
indicate how you would like new objects to appear in the picture
window.

-?\

M&

Xa general, Ideal Size refers to the size the objects appear in the
preview box. However, some objects have been scaled to fit into
the preview box. Therefore, Ideal Size most accurately refers to
the sae ia which the objects were predrawn awl look best in terms
of detaU and proportion.
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<& File Edit Goodies

] More Objects [

Delete Page
This menu item allows you to remove the current story page. When
you select Delete Page, you will see the following dialog box, which
asks you to verify that you wish to remove this page from your story.
You may not delete the Tide page of your document
Vou are about to PERMRNENTLV
< & remove this page.

c

[ Cancel 1

OK

D

A deleted page cannot be retrieved. Once a page has been deleted,
the pages of your story are automatically renumbered.
Insert a Page
This menu item allows you to add a blank page before the current
story page. When you select Insert a Page, you will see the
following dialog box, which asks you to verify that you wish to add\
new page to your story. You will then be asked to select what your
new page will look like.
Insert new page before

& > current page?

[ Cancel 1 [ Insert 3
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An inserted page is added before the current story page. You may not
insert a page before the tide page. Storybook Weaver allows you to
create a maximum of SO pages per story. When inserting a page into
your story, the pages of your story are automatically renumbered.
Copy a Page
This menu item allows you to duplicate a previously drawn page on
to the current page. The entire page, including the current scenery
and objects in the picture window and the text, is affected. When
you select Copy a Page, you will see the following dialog box, which
asks you to enter the number of the page you wish to copy onto your
current page. The number of pages in your current story document is
indicated. If you mistakenly type a number out of that range, you
will hear a system beep. You may not copy the tide page.
Copy a Page
There are 2 pages in Untitled.
Copy page IB I *° *he current page.

c

[Cancel!

OK

3

Swap Page
This menu item allows you to change the order of your storybook
pages, exchanging one complete story page for the current story
page. When you select Swap Page, you will see the following dialog
box, which asks you to enter the number of the page you wish to
exchange with the current story page.
Swap Page
There are 2 pages in Untitled.
Swap page IB 1 with the curr e n t p a g e .

c

[Cancel]
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The dialog box reminds you of how many pages are in your
document If you mistakenly type a number out of that range, you
will hear a system beep and return to this dialog box. You may not
swap the tide page with the current page.
GoToPage...((3-G)
This menu item allows you to go to any page in your current story
document When you select Go To Page... or press (3-G, you will see
the following dialog box, which asks you to enter the number of the
page you want:

Go To Page
There are 5 pages in Untitled.
Go to Page: | 3 I
OK

[CanceTl

The dialog box comes up with the current page highlighted. Type the
page you want and press Return or click on the OK button. The
dialog box reminds you of how many pages are in your document If
you mistakenly type a number out of that range, you will hear a
system beep and return to this dialog box.
When you go to a page, the cursor will be placed in the picture
window of that page. This menu item allows you to quickly go to
any page within your story without having to use the page-turning
buttons located at the bottom of the main work screen.

when asked what page number you want
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Q. How should I introduce Storybook Weaver to my students?
A. See the "Use in an Instructional Setting" section, beginning
on page 73. This section provides many suggestions for using
Storybook Weaver. You will also want to look at "A
Step-by-Step Look at Storybook Weaver" section, beginning
on page 15, which introduces many of the program's features.
Q. At what grade level should Storybook Weaver be
introduced?
A. Storybook Weaver centers around the theme, "my world
around me," which reflects writing activities often assigned to
primary students. Therefore, we have recommended
Storybook Weaver for grades K-3. However, Storybook
Weaver has been designed for use with any grade level and
has many features and flexibility that older students will find
appealing. Therefore, we encourage students in any grade
level to create storybooks using Storybook Weaver.
Q. Should I introduce all the features before my students use
Storybook Weaver?
A. No. See the "Use in an Instructional Setting" section. We
suggest introducing features gradually over an extended
period as they are required.
Q. How should I end a Storybook Weaver session?
A. Select Stop from the tool palette on the main work
screen. When you have returned to the main menu, select "I
would like to quit for now." If you plan to use another
program, close the Storybook Weaver Program disk, select it,
and select Eject from the Disk menu. If you plan to end all
work at the computer, close the Storybook Weaver Program
disk and select Shut Down from the Special menu.
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Q. Does Storybook Weaver work over a network?
A. Yes. Storybook Weaver runs on networks that support GS/OS
System 5. You will need to purchase a special network
version to load onto the file server. Contact MECC
Membership Services for information on the network version.
Q. How do I make data disks?
A. Use Disk Accessory available under the Apple menu on the
Storybook Weaver disk. The disk will be formatted and can
be used for storing Storybook Weaver files.
Q. Why are some menu items gray?
A. Nothing is wrong. Certain menu items are not available when
objects or text have not been selected or until some other
required action is taken. For example, Bring to Front and Send
to Back on the Goodies menu are not available until you
have placed selected objects in your picture window.
Q. Why are the buttons on the Title page and the buttons on
the tool palette gray?
A. If the buttons on the Tide page and tool palette are gray,
Storybook Weaver is in "read only" mode. Storybook Weaver
does not allow editing in this mode. To activate the buttons,
you must return to the main menu to make another menu
selection.
Q. What is the largest number of objects I can have on a
angle page in Storybook Weaver4!
A. Storybook Weaver limits the number of objects per page to
SO. If you try to add more than 50 objects per page, you
see a dialog box warning you that you have reached the
object limit
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Q. What is the largest document size you can have in
Storybook Weaver?
A. Storybook Weaver documents are limited to 50 pages.
Depending on the amount and size of the objects you have
used in your document, you may run out of memory before
the 50-page limit.
Q. What Teacher Options are available with Storybook
Weaver?
A. You can set various options by selecting Preferences on the
File menu. You can select small or large font, the page type
you desire, if moved objects are brought to the front of other
placed objects, the printed format of your story, and how new
objects will appear in the picture window.
Q. If I want my students to color their printed story pages,
using crayons, markers, or colored pencils, will
Storybook Weaver print "coloring book'9 pages?
A. In order to provide a printed outline drawing of the story page
for students to color, we suggest you select the color option
for your scenery and do not color objects that you place in the
picture window. In that way, Storybook Weaver will print
your story in an outline format for students to color.
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Writing is a thinking process. For children, learning to read and write Using Storybook
Weaver with Your
begins early in life and is ongoing, developing in concert with oral
language. Writing requires active participation in activities that have Students
meaning in children's daily lives and involves interaction with others.
Storybook Weaver provides your students with an open-ended
writing tool that allows them to discover the writing process that best
fits their writing style. Our intent is to provide an environment that
puts students in control of their writing. Great care has been taken to
provide students with flexibility in their approach to writing.
Students can begin by creating a picture or working on their story
text Students can also work between picture and story as they
compose and edit their storybook pages.
Storybook Weaver encourages a process approach to writing. In
process-oriented classrooms, children learn to write by actively
engaging in writing whole and meaningful texts. Children select their
own topics, formulate ideas, compose drafts, interact with peers,
revise, edit, and publish their work for real audiences. As the process
unfolds, the writer may return to any one of these activities at any
time.
Students write most successfully when they have some knowledge of
the topic. Storybook Weaver focuses on a central theme familiar to
primary-aged students—"my world around me." These day-to-day
experiences provide a solid foundation on which young students can
expand and explore their world through writing.
Since children possess a wide range of reading and writing skills,
Storybook Weaver provides both an introduction to writing for some,
while for others it provides a rich, creative environment to encourage
the elaboration of learned writing skills.
This section presents a variety of suggestions for incorporating
Storybook Weaver into your classroom writing environment You'll
find ideas for getting started, composing, drafting and revising,
sharing and publishing, collaborative writing, writing across the
curriculum, storytelling, reading aloud, connecting reading and
writing, and integrating literature.
During writing, students intertwine thoughts, ideas, experiences,
pictures, and words to create an intricate story fabric. Through
writing, students discover the wholeness in their intricately woven
tapestry.
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Getting Started with
Storybook Weaver

With the large choice of inviting scenery and varied objects available
in Storybook Weaver, motivating students to write will be easy! Yet
students will differ in their approach to Storybook Weaver. Younger
students may use the scenery and the objects to guide their writing.
They may draw their picture first and mold their story to fit the
picture they have created. Older students, with more writing
experience, may come to Storybook Weaver with their ideas thought
through, ready to compose, then utilize Storybook Weaver to
illustrate the ideas communicated through their writing.
Whatever the approach, we suggest that when you introduce
Storybook Weaver to your students, you initially encourage the use of
this product as a browsing tool. Students need the opportunity to
explore, not only the interface of the product but also the variety of
scenery and objects that are available for use.
As you introduce Storybook Weaver to your students, you may wish
to use the "Step-by-Step Look at Storybook Weave?' section to
familiarize them with die main work screen, scenery and object
selection, and the features of this product Provide time for students
to create pictures before you expect them to write a story. Through
this exploration, students will generate ideas for their writing. In that
way, their further experiences with Storybook Weaver will allow
them to focus more on writing, composing, and using the objects and
scenery to illustrate their story ideas.
Here are several prewriting suggestions that you can use with your
students as they explore Storybook Weaver.
• Have students select a topic for their writing or you may
suggest a topic. Then, use talk as prewriting. Probe,
prompt, praise, and question children to help them process the
knowledge they already possess. Let them talk with their
friends about their ideas before embarking on a writing
process. The natural talk that occurs as students interact
with Storybook Weaver will spark their imaginations about
story possibilities.
• The old adage, "a picture is worth a thousand words" has
particular significance for early writers. Drawing tells stories,
clarifies thoughts and ideas, and expresses feelings.
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Have your students create a picture that they can use to tell
a story to peer groups before they begin writing. This
thinking aloud about who is going to be in the story, where the
story will take place, when it will happen, and how the story
will end provides students with a framework as they actually
begin their writing. Research has shown that, for most
students, the period spent "thinking" about their story
before they sit in front of a computer and begin writing is time
well spent—especially when student time at the computer is
limited.
• Read to your children; read books, stories, magazines, comic
strips, poems. Likewise, encourage them to read by
themselves, since the more they are exposed to other people's
writing, the more background they'll have for their own use.
We have provided a sampling of children's books that reflect
a theme similar to that of Storybook Weaver's later in this
section.
• Story starters can be used to generate ideas for writing. Story
starters are as many and varied as your imagination. In
Storybook Weaver, they can take the form of a sentence that
appears in the story window of the main work screen, a
picture you have created in the picture window, or a
combination of both. We have provided some story-starter
ideas on pages 82-84.
We suggest introducing Storybook Weaver to your students using a
guided exploration approach. This method uses your writing
curriculum as the basis of the writing tasks. As students encounter
difficulties or inquire about new Storybook Weaver functions, the
functions are introduced either individually or collectively. An
advantage of the "on-demand" method is that it allows you to
continue your writing curriculum and activities with as litde
interruption as a new piece of technology can allow. The technology
is available on a "need-to-know" basis; that is, it is introduced at a
critical moment and not before.
Obviously, with a guided exploration approach, some students may
never inquire about certain functions or may not be aware of an
alternative and efficient method. In some cases, students may need
functions or options but never ask for them. Students may get to a
performance plateau or level of user sophistication but not go beyond
it
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Additionally, you may need to repeat instructions about a Storybook
Weaver function several times. If functions are introduced only as
students need them, several explanations may be needed before the
entire class has mastered them.
If you use a guided exploration approach, you may want to organize
writing teams or student writing pairs to assist with the dissemination
of knowledge.

Drafting,
Composing, and
Revising

Writing is a powerful instrument of thought. In the act of composing,
writers learn about themselves and their world and communicate
their insights to others.
As students begin composing or drafting their stories or writing
assignments, Storybook Weaver can be used in several different
ways. Students may compose at the keyboard, transcribe their
handwritten work at the keyboard, or dictate their writing to an older
student, parent volunteer, or teacher. Storybook Weaver can be used
to get ideas down quickly.
It is at this stage of the writing process that students begin to get a
real sense of the effort and energy that goes into writing. Using the
simple word-processing features in Storybook Weaver, students can
write readily, producing written work that is longer, neater, and more
fully developed Through entering and editing text, students can
create a story that flows smoothly from beginning to end.
For young students, their oral-language skills are often more
developed than their written-language skills. In their writing,
students often avoid the use of words that they can't spell, even when
invented spelling is encouraged. Storybook Weaver's "Spell" button
allows students immediate access to the correct spelling of any object
placed in their picture window. In this way, Storybook Weaver
encourages students to focus on their storyline during composition
and encourages the use of their rich oral language.
One of the most frequendy cited advantages of working with a word
processor is the ease with which text can be edited. Storybook
Weaver can be used to rewrite draft versions, add and delete words
and sections of text, and organize paragraphs and pages. Features,
such as cutting and pasting text and page options, are available under
the Edit menu or the Goodies menu. Command Key options provide
direct access to these features.
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Writing is meant to be shared. Storybook Weaver makes publishing
an easy and attractive way for students to share their writing with
others. Students can take pride in the printed stories produced as a
finished product. A student's printed copy of a Storybook Weaver
document will appear as it does in the picture and story window on
the main work screen.
Storybook Weaver's print options allow for one or two story pages
per printed page. Stories may be printed in gray-scale or color on an
ImageWriter II or in gray-scale on a LaserWriter printer.
Toward the end of the writing session, you can come together as a
group to share—to read and celebrate completed texts as well as texts
in progress. Offer praise and support for the efforts and
accomplishments of your writers.
In one-to-one sharing the purpose is to simply share a good story.
Children read their stories to one other person whose job it is to
simply understand what has been written. The listener asks
questions, makes comments, and offers support and encouragement
In whole-class sharing children can share what their partners had
written with the class. The listener must understand and remember
enough of the details to tell the other children about the story.
You can help the children share their writing by binding stories into
books to be used during sustained silent reading.
You can share writing with the larger community. This introduces
children to the concept of audience.
Here are some other suggestions for story sharing:
• Designate a child as the author of the day. Bring a
microphone and podium into the classroom for students to
read a story aloud to the class. The microphone and podium
add a professional feel to reading that primary-aged students
enjoy. If a microphone and podium are not available,
designate an author's chair for story sharing. Be sure to invite
other classes, your building principal, parents, and others to
share in these story sessions.
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Sharing and
Publishing Student
Stories

Storybook Weaver
• Use Storybook Weaver's "Choose a story to read" option
from the main menu to share writing. In a one-computer
classroom, you can attach an LCD (liquid crystal display) to
the computer to project the story on a large screen. Then use
the page-turning buttons to read the story text
• If you are writing in a computer lab environment, load
completed stories and have your class rotate through the lab
reading a story at each computer workstation, Selecting
"Choose a story to read" from the main menu protects the
author from having unauthorized editing done to the story.
• Bind student stories into books. Using Storybook
Weaver, students' stories can be printed for them to keep and
read over and over again. While there are many techniques
for binding books, a simple procedure is outlined on this
page.
• Bind student stories into one large class book that can be
laced in your classroom, building library or media center. A
collection of class books available for parents to enjoy during
conferences and school visits is an exciting way to share your
student's writing.

Binding a Story
into a Book

To prepare a story for binding, choose your printed page format by
selecting one or two story pages per printer page. This is set under
Preferences on the File menu. Print the story by selecting "Choose a
story to print" from the main menu of Storybook Weaver.
Once the story has been printed, assemble the pages by placing each
page in the story sequence. If the story has been printed on form
feed paper, separate each page-before binding.
Create an endpaper by placing a heavy piece of colored paper
(8 1/2" x 11") in the front and the back of the assembled book pages.
Staple the pages together along the binding edge. This will create the
book spine. You may prefer to sew the book pages together at the
spine using a running stitch on a sewing machine.
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Make book covers by gluing two 6" x 9" cardboard rectangles to a
single sheet of wallpaper. Fold the wallpaper over the inner edges of
the cardboard and secure with glue. (Dry mount tissue and fabric also
make nice book covers.)
Then glue the endpaper to the inside front cover of the book. Do the
same with the endpaper at the back of the book. Your book is
finished!
Add a copy of the bound books to a classroom library and send a
copy to the central library or media center.
Collaborative writing is an activity that sparks children's talk about
Collaborative Writing
writing. Adults often co-author stories, articles, and books. Children with Storybook
should be afforded the same opportunity for co-authorship.
Weaver
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Collaborative writing has a unique application within a computer
environment Children can merge their ideas into one coherentlooking text and can make revisions without having to recopy the
entire text Collaboration makes good use of a limited number of
computers in the classroom or school. And children enjoy occasional
social experiences as they spend time discussing writing in a
computerized writing class.
Traditionally, writing collaboratively involves pairs of students
creating one text together. Throughout the process, partners suggest
and revise their story from the perspective of a writer and a reader. A
shared experience or subject matter facilitates the creation of a shared
text
Storybook Weaver provides a vehicle for students to write
collaboratively. Students can work together to generate ideas,
compose and revise, and gain feedback and share their writing.
Students initial exposure to collaborative writing may involve helping
each other with their writing by being a good listener or audience and
trying to understand the writer's intention. The following suggestions
provide ways for students to write collaboratively.
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Using student groups to generate ideas:
• Brainstorming is done either with a partner or in a resource
group. The list of ideas becomes a stimulus to help students
choose a topic.
• Usually students decide on a topic individually and then
work collaboratively to organize the story. This might be
done using the technique called "scripting," whereby students
take turns discussing one another's stories. Students address
such aspects as what ideas to include, how to start the story,
and the story sequence.
Using student groups to compose and revise:
• Once the student has chosen a topic and organized the story,
the partner continues to be a resource during this process as
students check with one another about the clarity and
communication of their ideas.
• Students may often print two story copies, one for their own
proofreading and the other for their writing partner to edit.
These suggestions become the basis for revisions.
Using student groups to gain feedback and share writing:
• Students may share their finished writing with their writing
partner by reading aloud or reading printed storybooks.
The writing partners provide feedback about the story and
how it communicated the author's message.
Storybook Weaver can be used for cross-age collaborative writing as
younger students work with older students to create a story. In this
environment, younger students develop verbal communication skills,
learn computer skills, and use their imaginations. Older students
develop a sense of responsibility for providing effective learning
experiences for younger children while developing their skills in
organization.
Collaborative writing can be a way of learning more about what
happens in the writing process as children talk over their plans, ideas,
and decisions with others. For those students who enjoy the team
experience and the ideas generated in a group, team writing has many
possibilities.
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Students learn to write by writing. The specific purposes for writing
vary widely, from discovering the writer's own feelings to
persuading others to a course of action, recreating experiences
imaginatively, reporting the results of observations, and more.
Writing assignments should reflect this range of purposes. Student
writers should have the opportunities to pursue writing that is
important to them. They should also have the opportunity to use
writing as an instrument of thought and learning across the
curriculum.
The theme of Storybook Weaver, "my world around me," is closely
tied to similar themes in the most popular classroom texts in many
areas of the curriculum. Our hope is that through this parallel theme,
Storybook Weaver will encourage students to view writing as an
integral part of each school day in all curriculum areas. Here are
some suggestions:
• Prepare an alphabet book with a page for each letter of the
alphabet Accompany each letter with an illustrated example.
Number, color, and shape books can be prepared in the same
manner.
• Write autobiographies or biographies of your writing partner.
Include such things as favorite book, pasttime, and sport
These "me" books can be compiled at the beginning of the
school year and saved in "time capsules" to be reopened at
the end of the year.
• Use literature to stimulate writing. Rewrite a favorite class
story with new characters or a new setting. Extend a story by
writing a new ending.
• Write the results of science experiments or investigations and
illustrate them by using the graphics objects.
• Keep a journal using Storybook Weaver and let students
make daily or weekly entries. For young students, an entry
may consist of a picture and a simple sentence. Storybook
Weaver is an excellent tool for journal writing because of its
strong orientation to the child's world.
• Start correspondence with pen-pals in another class, another
school, or even an institution such as a retirement home or
day-care center. Use Storybook Weaver to write and
illustrate letters.
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Suggestions for
Writing Activities
Across the
Curriculum

Storybook Weaver
• Produce want ads, posters, recipes, "how to" directions,
invitations, and for-sale signs.
• Use round-robin writing, where each student adds a sentence
to a composition that you or another student has begun.
• Assign teams of students to a single writing assignment: a
story, an essay, or an article.
Writing can be the vehicle for learning—for learning about writing
and for learning about particular topics in content areas.

Story-Starters

Story-starters are often used to suggest a writing topic to students.
They plant the seed of a new story idea for the writer. With
Storybook Weaver, a story starter may consist of an intriguing
picture, a sentence in the story window, or a combination of both.
Story-starters provide a focus for the writer. Before beginning to
write, students should address such questions as:
who is going to be in the story;
where will the story take place;
when will it happen;
what will happen first in the story;
what will happen after that;
how will your story end.
We have compiled a sampling of story-starters that can be used to
engage your students in writing. Needless to say, the possibility for
story-starters is limited only by imagination.

Nobody knev what vas on the other side of the fence.
Then one day ve decided to find out.
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The day was warm and sunny. V* were the only one* on
the sandy beach.
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Ve were just starting out on a hike when what should
we see eoming down the path.

uuess vnat ve found on the playground today!
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I was the first one to smell the smoke.

I waved out the window at my family as the I
to puH away.

started

You will never believe what happened at the zoo!
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Storytelling in the classroom offers natural opportunities for children
to grow as language users. Storytelling extends an invitation to read
and a natural progression from hearing, reading, and telling stories is
the writing of original stories.
From kindergarten through the intermediate grades, storytelling can
be used as a tool to reinforce comprehension skills, encourage
creativity, and stimulate interest in independent reading and writing.
Here are a few suggestions for encouraging storytelling through the
use of Storybook Weaver.
• Drawing is an important way to tell a story, especially for
the young child. Have students create a story to tell in
pictures. A wordless picture book can be created using the
scenery and objects available in Storybook Weaver and
omitting the story text Students can select the "Choose a
story to read" option from the main menu to share their
pictures as they tell the story.
• Use a tape recorder to encourage students to share their
stories with others. The tape can be used in conjunction with
the "Choose a story to read9 menu option or provide a
printed version of die story for students as they listen to the
taped story.
• Let writing become the basis for oral storytelling. Using a
story the student has written, have them practice the story
until they are comfortable enough that they can tell the story
to a group. Then schedule some storytelling sessions,
allowing students to use props if desired to make their
written stories come alive through oral language.
• Round-robin storytelling can be a written as well as an oral
experience. Have one student start a story by writing one
page. The next student continues the story, adding the next
page. This activity works best in small groups so that the
waiting time for the story to be written and shared is
relatively short To create a purely nonsensical tale, each
writer should begin on a new page that contains only the last
line of the previous writers portion. That way, none of the
writers knows what the others have written prior to the line
left to be continued. The illogical story makes for hilarious
oral reading.
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• Finally, encourage children to retell stories by modeling
storytelling for them. Choose a favorite story to tell to your
class. At the conclusion of the story, have students create
their own rendition of the story you have shared.
Storytelling permits children to become active participants in the
creation of language and allows book language to serve as a model
for their own.

Reading Aloud

One of the easiest and most effective methods of getting children
interested in reading good books is to read aloud to them. While we
often think of reading aloud as an activity associated with books in
print, Storybook Weaver provides a forum for reading aloud in an
electronic environment
Selecting "Choose a story to read9 from the main menu allows you
to engage in read-aloud story-sharing sessions using those stories
created with Storybook Weaver. Since this option allows no editing,
the page-turning buttons function much like turning the pages of a
book, allowing you to turn the page to continue the story.
As students listen to the stories, the reading and writing connection is
established.

Connecting Reading
and Writing

Writing is considered part of reading instruction. When children
write about topics of interest to them, writing becomes an integral
part of communication. Children learn about language by using it
themselves in a meaningful way. By reading and revising their own
writing, by reading and responding to other children's writing, and
by sharing their writing with peers, children begin to believe in
themselves as writers as well as readers.
When you watch students writing, you are watching reading. While
composing, children read continually. They read to savor what they
have written. They read to regain momentum. They read to edit.
Finally, they read aloud to share what they have written.
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For children, literature provides a model for comparison with
experienced writers. As children read, they are reading the creative
writing of others. In turn, when children write their own way, they
gain experience with the decisions an author has to make.
Literature provides a model for writers as well as a springboard for
children's writing. Books can offer a bridge to understanding that
other people have problems, feelings, and experiences like their own.
Some books provide themes to explore further, others lend
themselves to sequels that enable young readers and writers to
explore what happened "after" the end of the book. Still others
encourage children to write about similar subjects: a journey, a
place, or an interesting person.
We believe that in order to teach writing, you must surround your
students with literature. Therefore, we have compiled a sampling of
popular children's books that appear in various bibliographical
listings for young children. These books have been selected because
they reflect themes or settings that can be used to extend writing
with Storybook Weaver.
For each book listed, we have included the complete tide, the author
(or authors), illustrator, publisher, copyright date, and an annotation.
Annotations are brief in order to give you just an inkling of each
book's content
Equal attention was given to retain those timeless books that have
been favorites of generations of children and to include
contemporary books that are well on their way to becoming classics
in their own time.
While not every book will appeal to every child, this listing serves as
a starting point as you weave literature into your writing classroom.
It is not intended to be exhaustive. We encourage you to consult
your school or local library for additional recommendations.
By weaving together the arts of reading, writing, speaking, listening,
and thinking, Storybook Weaver provides students with the
opportunity to make literature their own through writing.
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All the Way Home
Lore Segal
Illustrated by James Marshall
Farrar, 1973
A cumulative crying, barking, meowing, squawking, and
grinning story.
Amy Goes Fishing
Jean Marzollo
Dial, 1980
Amy's brother and sister tell her that fishing is boring. But
she goes fishing with her father anyway and they have a lot of
fun.
And to Think That I Saw It on Mulberry Street
Dr. Seuss
Vanguard, 1937
A small boy's imagination conjures up an amazing parade, bit
by bit, inspired by the sight of a "plain horse and wagon on
Mulberry Street"
Apricot ABC
Miska Miles
Illustrated by Peter Parnall
Litde Brown, 1969
A story of the world of nature. This book could encourage
children to describe what's happening in the countryside.
Baby Farm Animals
Merrill Windsor
National Geographic, 1984
This is a lovely collection of mothers and their kids, calves,
chicks, lambs, goslings, foals, and piglets—at home.
The Big Yellow Balloon
Edward Fenton
Illustrated by lb Ohlsson
Doubleday, 1967
Chain reaction that occurs when a cat chases Roger's giant
balloon.

86

Storybook Weaver
l^iial instructional Setting

x^i?x?x^x^S?x^^SSiSx^^K^^^S
:%.x^x.x.>x^x^X'.>x.x«-x«-:-x.x-x-x-x-:
Sx3x$£i^x3x&^^

Blueberries for Sal
Robert McCloskey
Viking, 1948
Blue-and-white pictures portray Sal and her mother gathering
blueberries on the same mountain as litde bear and his
mother.
Brown Bear, Brown Bear What Do You See?
Bill Martin, Jr.
Illustrated by Eric Carle
Holt, Rinehart & Winston, 1967,1983
Rhythmic verse and vivid colors combine to capture the
attention of the youngest and simple text that is based on an
old call-and-response game. As it progresses from red bird
and yellow duck to mother and children, children will soon
join the chant

j ^ ^ \

Caps for Sale
Esphyr Slobodkina
Addison-Wesley, 1947
While a tired peddler sleeps, some mischievous monkeys take
all the caps he has piled on his head.
A Children's Zoo
Tana Hoban
Greenwillow, 1985; Mulberry, 1987
This beautifully designed book of eleven animal portraits is
just right for a book-souvenir of a trip to the zoo. On the last
page, the author tells where each animal lives and what it eats.
Come On Up
Joy Kim
Illustrated by Paul Harvey
Troll, 1981
A big cat easily climbs a tree, then invites all its animal
friends to "come on up." Some friends, like the bird, manage
easily, but the litde cat has trouble. The litde cat can't climb
that high at first, but everything changes when the big dog
comes along.
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Dawn
Uri Shulevitz
Farrar, 1974
An old man and his grandson sleep by the lake in the stillness
of the night Slowly, signs of a new day awaken them, and
they row to the middle of the lake to experience the dazzling
dawn.
Did You Carry the Flag Today, Charley?
Rebecca Caudill
Illustrated by Nancy Grossman
Holt, 1971
Independent five-year-old Charley manages to receive the
highest honor in school—being chosen to carry the flag
because he is the most helpful.
Don't Forget the Bacon
PatHutchins
Greenwillow, 1976
A humorous tale for every child and adult who has ever been
sent to the store to pick up grocery items—only to forget the
names of the items along the way.
Farm Morning
Harcourt Brace Jovanovich, 1985
A litde girl and her father do early morning chores together in
the barnyard.
Fog Drift Morning
Deborah Kogan Ray
Harper & Row, 1983
A mother and daughter walk happily together by the sea
shortly before dawn.
Freight Train
Donald Crews
Greenwillow, 1978
As a freight train passes through the pages of this book, the
reader is introduced to all its different cars.
Harry by the Sea
GeneZion
Illustrated by Maragaret Bloy Graham
Harper, 1965
Family's pet dog causes an uproar at the beach.
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Hide and Seek Fog
Alvin Tresselt
Illustrated by Roger Du Voisin
Lothrop, 1965
Fog at the seashore.
A House Is a House for Me
Mary Ann Hoberman
Illustrations by Betty Fraser
Viking, 1978; Puffin, 1982
Lilting, rhythmic verse and detailed illustrations show all
kinds of houses for all kinds of creatures and things, including
a shell for a clam, a dog for a flea, a bam for a lamb, and a
pod for a pea.
I Can Ride It!
Shigeo Watanabe
Illustrated by Yasuo Ohtomo
Philomel, 1981
A very large bear cub gets on a small tricycle. After riding
the tricycle, the cub graduates to a bicycle, then to skates, and
finally tries a skateboard. The cub can ride all these
vehicles—almost.
I Know a Lady
Charlotte Zolotow
Illustrated by James Stevenson
Greenwillow, 1984
Here the seasons are explored by following the relationshp
between an old woman and two children who live down the
street and enjoy her flowers in summer, her treats in winter,
and her love all year long.
I Love You Mouse
John Graham
Illustrated by Tomie de Paola
Haicourt, 1976
A young boy imagines all the things he would do if he were
the parent of various animals. For each he would provide
shelter and share in their favorite pastimes.
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In My Treehouse
Alice Scherde
Illustrated by Meridith Dunham
Lothrop, Lee & Shepard, 1983
A first-person account by a child who enjoys adventures real
and imagined by playing alone.
Inside, Outside, Upside Down
Stan and Jan Berenstain
Random House, 1968
In a book about positions, the Berenstains make clear the
relativity of positions and at the same time reveal objects that
can be described using more than one position.
Kimako's Story
June Jordan
Houghton, 1981
Kimako likes to sit on her front steps with her family and
watch the people on her street She also likes to read, but best
of all she likes to be outside with all her friends in the
neighborhood. Once for a whole week, she takes care of a
big, old dog that belongs to the woman down the block.
The Little House
Virginia Lee Burton
Houghton Mifflin, 1942,1978
A litde tum-of-the-century country house is used to show
the urbanization of America. With each page the reader/
listener becomes the litde house and begins to experience
the contentment, wonder, concern, anxiety, and loneliness
that the passing seasons and encroaching city bring.
Make Way for Ducklings
Robert McCloskey
Viking 1941
Mrs. Mallard and her duckings complicate Boston traffic
when they move from the Charles River to a new home in
Boston's Public Gardens.
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Marmalade's Yellow Leaf
Cindy Wheeler
Knopf, 1982
Marmalade the cat watches a yellow leaf falling to the
ground and being tossed by the wind. Chasing the leaf leads
Marmalade into a world of fall colors and adventure.
The Mice Came Early This Year
Eleanore J. Lapp
Illustrated by David Cunningham
Whitman, 1976
A child observes die preparations made by his family and
by the wild creatures outdoors as autumn approaches.
The Mystery of the Missing Red Mitten
Steven Kellogg
Dial, 1974
Annie searches for the fifth mitten she has lost in a single
winter.
Odd One Out
Rodney Peppe
Viking, 1985
Every picture in this book is a puzzle in which something is
wrong. The job of the reader is to find the error—for
example, a traffic light is in the garden and a monkey is at a
school desk.
On Market Street
Arnold Lobel
Illustrations by Anita Lobel
Greenwillow, 1981
Imagine a magical marketplace of twenty-six shops, one for
each letter of the alphabet, where the shopkeepers are their
wares: a women of wigs, for example, and a man made of
musical instruments.
One Morning in Maine
Robert McCloskey
Viking, 1952
Continues the story of Sal and her family on the day she
loses her first tooth.

r
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Over in the Meadow
Arranged by John Langstaff
Illustrated by Feodore Rojankovsky
Harcourt Brace Jovanovich, 1967
"'Sing,' said the mother. 'We sing,' said the three. So they
sang and were glad in their nest in the tree.'"
Sleep Out
Carol and Donald Carrick
Clarion, 1973
Dad is too tired to go camping, so Christopher and his dog
go off on their own and share a memorable adventure.
This Is the Ambulance Leaving the Zoo
Norma Farber
Illustrated by Tomie de Paola
EJ>. Dutton, 1975
A story of where and why the ambulance went tearing through
the city and past alphabetical landmarks. Children might try
their own alphabet adventures.
Time of Wonder
Robert McCloskey
Viking, 1957
Poetic words and pastel watercolors tell of a late summer
storm on an island in Maine.
Truck
Donald Crews
Greenwillow, 1980; Puffin, 1985
One large red truck moves through other vehicles on the
highway in different kinds of weather. The traffic signs and
billboards provide the only words.
Wheels
Jane R. Thomas
Illustrated by Emily A. McCully
Clarion, 1986
Elliot is thrilled with his new bike from Grandpa. Now he
can win the Saturday races at the park. But despite all of his
determination and fast pedalling, he only ties for last place.
Elliot stomps off to pout until Grandpa helps him understand
the real meaning of being a winner.
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Teachers are faced with the tremendous task of preparing today's
students for tomorrow's world—a world characterized by change in
an information-rich environment Thinking skills are at the heart of
this thriving, changing environment, for these are the behaviors
students must practice in school and continue to apply for the rest of
their lives.
It wasn't long ago that thinking skills were considered exclusive to
gifted and enrichment classes. Today, however, thinking skills are
viewed as an essential component of the total school curriculum.
Developing these skills is the goal of each individual discipline.
Many educators have, in fact, come to view thinking skills as perhaps
the most basic of the basic skills because they facilitate the
acquisition of all other learning.
At MECC, we view computer software as a vehicle for fostering
students' thinking. Our products are curriculum-based, with thinking
skills as a thread within subject areas. This provides an environment
with many opportunities for teachers to highlight and reinforce
thinking skills.
We believe teachers play a critical role in determining the classroom
environment for thinking. Naturally, many teachers have taught
thinking skills and will continue to do so using a variety of strategies.
Our commitment is to provide teachers with the materials that help
them do their job well: high-quality software that promotes the
application of thinking skills.
Our approach to thinking skills reflects what both research and
effective classroom practice has shown. That is, the approach that is
most effective and appeals to most teachers is one that infuses
thinking skills into existing content areas. Educators have told us
they are interested in thinking skills as a method used in the
instruction of a topic, not as a subject By infusing thinking skills
into existing content areas, MECC products integrate easily into
teachers' curricula while providing a rich environment for students to
practice skillful thinking. We strive to meet the challenge teachers
face in promoting the skills that students need.
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If schools are to integrate the teaching of thinking with regular
academic instruction, they need to know what aspects of thinking to
teach. After exploring the research that has been done in the area of
thinking skills, MECC has chosen as a base the Dimensions of
Thinking framework, published in 1988 by the Association of
Supervision and Curriculum Development (ASGD). We chose this
framework because it pulls together research and models from a
variety of sources and brings the theory to the classroom level,
applying it to that environment In addition to knowing the subject
matter that is covered, teachers now can see the specific thinking
skills that are challenged within a product
This section highlights ways in which teachers can use Storybook
Weaver to promote thinking skills with their students. The following
pages provide examples of how Storybook Weaver relates to the
ASCD core thinking skills framework. Although only one thinking
skill per category is correlated to a specific part of the product, each
skill can be practiced on many levels and in many aspects of the
product
We realize the importance of thinking skills in the curriculum. We
believe it is essential that students be taught thinking skills so that
they have the tools to understand the past, deal with the present, and
prepare for the future. We are confident that you will find Storybook
Weaver of considerable value in your classroom as you foster
student thinking.
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A Framework for Thinking
The components used in thinking are referred to as core thinking skills. This framework
defines those skills that appear in the repertoire of the model learner. Each skill selected is
documented in research as important to learning or thinking, is teachable, and is valued by
educators as important for students to learn.
The core skills of the ASCD framework are listed and defined below with examples of
applications within Storybook Weaver. The skills are neither discrete nor hierarchical. In fact,
individual skills draw on other skills and can be used repeatedly in the thinking process.
The selected examples are not exhaustive but highlight ways in which these thinking skills
are used in Storybook Weaver.
Source: Dimensions of Thinking, Association for Supervision and Curriculum Development (ASCD), 1988.

Definition of Core
Thinking Skills Categories
Focusing Skills allow
students to attend to selected
pieces of information and
ignore others. Focusing occurs
when students sense a problem,
an issue, or a lack of meaning.

Core Thinking
Skills Components
Focusing Skills
• Defining Problems
• Setting Goals

Storybook Weaver
Application
Prewriting activities help
students define their writing
tasks. In the writing process,
students define their audience
and write with a purpose.
Using Storybook Weaver,
students determine the writing
process that best fits their
writing style.

Information Gathering Skills
involve obtaining information
and clarifying issues and
meanings through inquiry.

Information Gathering Skills
• Observing
• Formulating Questions

As students select the topic
for their story writing, they
must focus on questions such
as who is going to be in the
story; where will the story
take place; when will it
happen; what will happen
first in the story; how will the
story end.

Remembering Skills are
those activities or strategies
that students consciously
engage in to store and retrieve
information from long-term
memory. Activating prior
knowledge falls under this
category.

Remembering Skills
• Encoding
• Recalling

Storybook Weaver focuses on
a central theme familiar to
most primary-aged students:
my world around me.
In writing with Storybook
Weaver, students draw from
their previous experiences as
they develop their story ideas.
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Definition of Core
Thinking Skills Categories
Organizing Skills are used
to arrange information so
that it can be understood or
presented more effectively.

Analyzing Skills are used to
clarify existing information
by examining parts and
relationships. Through
analysis, students identify
and distinguish components,
attributes, claims,
assumptions, or reasoning.

Core Thinking
Skills Components
Organizing Skills
• Comparing
• Classifying
• Ordering
• Representing

Analyzing Skills
• Identifying Attributes
and Components
• Identifying Relationships
and Patterns
• Identifying Main Ideas
• Identifying Errors

Storybook Weaver
Application
Throughout the writing
process, Storybook Weaver
affords students the
opportunity to represent their
writing through pictures. The
pictures they compose
communicate their story ideas
to their audience.
Editing, revising, and proof
reading are tasks that provide
opportunities for students to
identify errors in their writing.
The continuous reading that
takes place as students write
helps them to refine their
written communication.

Generating Skills involve
using the students' prior
knowledge to add information
beyond what is given.
Connections between new
ideas and prior knowledge are
made as new information and
ideas are recast into new
structures.

Generating Skills
• Inferring
• Predicting
• Elaborating

As students progress through
the writing process, they
elaborate on ideas generated in
prewriting and drafting stages.
Using Storybook Weaver,
students can elaborate on their
writing through the pictures
they create as an
accompaniment to their text.

Integrating Skills involve
putting together die relevant
parts or aspects of a
solution, understanding,
principle, or composition
and incorporating this
integrated information into
a new understanding.

Integrating Skills
• Summarizing
• Restructuring

Throughout the writing
process, students restructure
their story integrating
feedback from peers and
teachers. As students share
their writing with others, they
gain experience important to
their development as writers.

Evaluating Skills involve
assessing the reasonableness
and quality of ideas.

Evaluating Skills
• Establishing Criteria
• Verifying

All writing sessions should
include opportunities for
students to share their writing
with others. With Storybook
Weaver, students may select
"Choose a story to read" to
share electronic storybooks
with their classmates.
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The MECC team responsible for the development of Storybook
Weaver includes Charolyn Kapplinger, Patricia Korn, John Krenz,
Brian Nesse, Jean Sharp, and Steve Zehm.
Storybook Weaver would not be the product it is without the help and
input of Craig Solomonson, who provided design support, Vincent
Erickson and Susan M. Gahrys, who provided technical support, and
Technical Support Services, who provided product testing.
The development team gready benefited from the preliminary
research and planning completed by the Language Arts Team,
including Sheila Dols, Dave Duffee, and Michael Palmquist
MECC extends a special thanks to the following educators and their
students for their assistance in the development of this product:
Kathy Brown
Island Lake Elementary School
Shoreview, Minnesota
David Weisser
Park Avenue Computer Learning Center
Minneapolis, Minnesota

TO THE READER:
MECC has made every effort to ensure the instructional and technical
quality of this courseware package. Your comments—as user or
reviewer—are valued and will be included in any future revision of
the product Please address comments to:
MECC Software Division
3490 Lexington Avenue North
St Paul, MN 55126
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Scenery Choices

You can choose from a variety of colors and scenes for your story
scenery. Six background colors and six foreground colors can be
interchanged to create 36 color combinations. Six background scenes
and six foreground scenes can be interchanged to create 36 scene
combinations.
The chart below shows the options available when you select the
scenery button from the tool palette.

Scenery Choices
Colors
White
Aqua
Blue
Purple
Grey
Black

Backgrounds

White
Gold
Green
Forest
Brown
Black

Foregrounds
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Scenes
Coast
Alpine
Farm
Qty

Ocean
Sky
Lake
Path
Reld
Street
Road
River

/*^^^fc\

Storybook Weaver

r

iices
Object Choices
The objects available for placement in the picture window are
available by selecting "Objects" from the main work screen of
Storybook Weaver. Over 300 objects are sorted into eight categories.
The chart below lists the categories and objects available in
Storybook Weaver. Nine objects are available at any given time on
the objects selection screen. You may, however, scroll through the
entire list of objects available in a given category by clicking on the
arrows that appear beneath the object selection boxes. The last object
displayed on a given selection screen is underscored in the list below.
Category
* *
people

pM?

Name
People (Children)

People (Adults)

Objects Available
baby
baby crawling
ball player
baseball player
biker
boy
boy sitting
camper
figure skater
fisher
football player
girl
girl sitting
hiker
hockey player
jogger
kite fiver
paper carrier
pitcher
roller skater
rope jumper
snow shoveler
snow thrower
soccer player
swimmer
toddler
babysitter
barber
beautician
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Name
People (Adults)

Objects Available
bus driver
businesswoman
businessman
carpenter
chef
coach
crossing guard
delivery person
dentist
doctor
dogcatcher
farmer
firefighter
golfer

grandfather

grandmother
grocer
mail carrier
man
man sitting
mechanic
nurse
park ranger

passenger

pilot
police officer
surfer
teacher
truck driver
vendor
woman
woman sitting
worker

2£

Animals (Big)
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alligator
bear
buffalo
camel
collie
cow
deer
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Category

Name
Animals (Big)

Animals (Small)
onimols

Objects Available
dog
dolphin
donkey
elephant
fox
goat
gorilla
hippopotamus
horse
kangaroo
leopard
lion
Pig
polar bear
seal
shark
sheep
tiger
whale
zebra
beaver
bird
bird flying
calico cat
cat
chicken
crab
duck
fish

frog
goose
lobster
monkey
mouse
owl
parrot
poodle
rabbit
raccoon
rooster
skunk
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Name

Category

Objects Available
snake
spider
squirrel
starfish
tabby cat
turtle
apple tree
beaver dam
bush
butterfly
cactus
cloud
com

Nature
nature

fi r e

flowers
grass
hay stack
leaves
lightning
lily pads
log
moon
mountain

mushrooms
nest
palm tree
pine tree
pond
puddle
pumpkin
rain
rainbow
rock
sand
smoke
snow
snowman
sun
tornado
tree
tree stump
wood
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Category
yy^.

vehicles
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Name
Vehicles

Objects Available
airplane
ambulance
bicycle
blimp
boxcar
bulldozer
caboose
canoe
car
city bus
coal car
convertible
dump truck
fire engine
flatcar
garbage truck
gasoline truck

hay wagon

helicopter
hot-air balloon
ice-cream track
jeep
limousine
locomotive
mail truck
motorcycle
pickup truck
police car
race car
rowboat
sailboat
school bus
scooter
semitrailer
ship
speedboat
sports car
station wagon
steam engine
J ^ ^ \
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Name

Category

Shelter

Objects Available
tanker car
taxi
tow truck
tractor
van
activity center
airport
apartment
bakery
bank
barbershop
bam
bookstore
clinic
clothing store
clubhouse
dance studio
doghouse
factory
farmhouse
fast food
fire station
flower shop
garage
gas station
grocery store
hardware store
hotel
house
ice-cream shop
laundry
library
log cabin
mobile home
movie theater
park shelter
pet store
phone booth
police station
post office

shelter
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Category

Objects Available

restaurant

j

t

things

r^

Things

school
silo
skyscraper
storage shed
store
toy store
trailer
tree house
video store
apple
balloon
baseball
basketball hoop
beach ball
bone
book
brick wall
bridge
cage
circle
collection box
doll
fence
fire hydrant
flag
football
garbage can
garden hose
hot dog
ice-cream cone
kite
ladder
lantern
lawn chair
lawn mower
mailbox
newspaper
oval
package
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Category

Name

Objects Available
pail
picnic basket
picnic table
pole
radio

railroad tracks
rake
rectangle
sand casde
sandbox
scarecrow
seesaw
shovel
skateboard
slide

soccer ball
square
stop sign
street light
stroller
swing set
teddy bear
tent

die swing

traffic light
triangle
tricycle
umbrella
vendor cart
wagon
weather vane
wheelbarrow
wheelchair
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You can prepare a data disk to save your stories before you launch
Storybook Weaver. The procedure for creating a data disk is very
simple. Just follow the standard procedure for starting up your
Apple IIGS using Storybook Weaver (see "Getting Started,"
beginning on page 7). When the desktop appears, instead of
clicking on the Storybook Weaver icon, eject the Program disk and
insert an uninitialized 3.5" disk in the disk drive. The program will
inform you that this disk is unreadable and will give you the
opportunity to change your mind about initializing it (This is done
to reduce the chances of accidentally erasing an important or
unlabeled data disk.) The prompt looks like this:

Creating and Using
a Data Disk

6S/0S does not recognize the file systca on
this disk (in device MPUDISK3.5I). Io von
wont to initioliit it?
Please oom this disk HUHBl I
[ Eject ] [ Continue )

r
After you have given the disk a name, click on the Continue button.
Another dialog box appears. Click on the Initialize button. The
program then initializes the disk for use with the Apple IIGS. Once
this process is complete, you can eject the data disk, reinsert the
Program disk, and resume starting Storybook Weaver.
You can also create a Storybook Weaver data disk by inserting a
blank, unformatted 5.25" disk in the Apple 525" Disk Drive. When
the disk is in the drive, double-click on the drive icon. You will
then be prompted to initialize the disk and follow the same
procedure as creating a 3.5" data disk.
a data disk while you doming Storybook
Weaver, use the Disk Accessory located under the m menu*
This utility will allow you to foraiat disks without quitting
\ FormoreinfonnationonD^
see pages 47-52*
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Organizing Your
Data Disk

A limit of 51 files can be saved in the disk or volume directory. On
a 3.5" data disk, the maximum number of files may be reached
before the data disk runs out of space. If you tried to save to a disk
with the maximum number of files, you would see the following
alert:

©

Unoble to sove because
volme directory is full.

To prevent this, you should create folders that can hold an unlimited
number of files. Then, save your documents to one of the folders
you have created. Folders can also help organize documents by
purpose, assignment, author, or type.

Key Combination
Command
Equivalents

G-A
(3-B
(3-C
(3-F
(3-G

3-1
(3-N
(5-0
C5-P
(3-Q
(3-S
C5-V
C5-W
(3-X
(3-Z
(3-?

Select All
Send to Back
Copy
Bring to Front
Go To Page
Ideal Size
New
Open
Print
Quit
Save
Paste
Close

Cut
Undo
Help
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